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Installing Smart Alec software
NOTE:

Please be sure that your computer system
meets the requirements for installation. These
are listed in “Appendix 1: Smart Alec
computer requirements” on page 123.

To install the Smart Alec system, insert the Smart
Alec CD in your CD drive. The Smart Alec installation
process will start automatically. Simply follow the
on-screen instructions.
Table 1: Installation notes
Condition
If the Smart Alec
installation process
does not start
automatically…

Instructions
…you can start it manually:
1. Select Start > Run…
2. Type E:\setup.exe where E is the letter of the CD ROM drive.
3. Click OK

If you already have
…this version of Smart Alec will ask if you want to migrate your
Smart Alec installed on database. If you answer No, you will lose all data. It is also suggested that
the computer…
you back up your database before installing this version of Smart Alec.
Should you have problems with migration, call Adaptive’s Technical
Support department at 1-800-558-7022.
…it may be because there is more than one DDE source for providing
If you get a message
data to the same variable. Please contact Adaptive Micro Systems’
that the database
cannot be migrated… Technical Support department at 1-800-558-7022 for assistance.
…run these programs (located on the CD) in this order:
1. w95y2k.exe
2. w95ws2setup.exe – Then manually reboot the computer.
3. y2kvdhcp.exe
4. corpupd.exe
If you have been using …after installation of this version, be sure to turn security on with
security authorization authorization levels in the System Administration application. Refer to
“System Administration” on page 93.
in the current
system…
…you must have Microsoft Internet Explorer installed on your computer.
In order to use the
online Help system for Internet Explorer is included on the Smart Alec installation CD.
Smart Alec or to supply
OPC data to Smart
Alec…
If you get a message
that you need to update
your Windows 95
computer for Y2K…
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Introduction to the Smart Alec software
Overview
Smart Alec is a software system that integrates data
from many sources, and sends that data to ALPHA
electronic signs, alphanumeric pagers, and email
systems.

Input vs. output
Data can come into the system from many sources
and can be in a variety of formats.
This data can be placed into messages which can be
sent to a number of viewing destinations. These
destinations are called “notification devices.” Messages
can be sent to the notification devices in a number of
ways.

Setup vs. management
Normally the applications that are needed to set up
the Smart Alec system are available only to an
administrator, while the applications needed for routine
management of messaging needs are available to all
users. In an environment where only one person is
responsible for using Smart Alec, this user is also the
administrator, with full access to all applications.

System security
Security for Smart Alec is available to be able to limit
access to some features or functions. This security applies
to Smart Alec applications and what users can do with
the applications, either read-only (“Details”) or both read
and update (“Update”) access. Security also applies to
system resources, such as hardware and data. A user will
be able to use an application or resource only if he has
authorization greater than or equal to the level
determined to be needed for that application or resource.
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Administrator vs. user security
Security is available so that, for instance, applications
needed only by the Smart Alec administrator (to set up
the system) are not accessible by normal users (for
general management of the system.)

Single-user vs. multi-user environments
A “single-user” environment in Smart Alec might
have more than one user, but all users have full access
rights to all applications, application functions, and
system inputs and resources.
A “multi-user” environment is appropriate when
users should not necessarily have access to the same
applications and application functions; that is, access can
be restricted for some users for applications, application
functions, or system inputs or resources. For example,
you may want to restrict a clerk’s authority and not allow
that person to send messages to the signs on the
production floor. But you would want the building
security manager to be able to send a fire alarm to every
sign. Also, you might not want either of these people to
be able to set authority for other users.
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Smart Alec applications
The applications (programs) available in Smart Alec
and their respective functions are as follows.

SA Bar
The initial Smart Alec application from which you
can start any other Smart Alec application for which you
are authorized. See “Starting the Smart Alec system”,
starting on page 21.

Notification Device Setup
Designate the names and properties to be used for
places where messages will be displayed (i.e., signs,
pagers, and email.) See “Identifying notification devices”
starting on page 38.

Notification Device Group Manager
Designate groups of notification devices so a user
can send a message to multiple devices simultaneously.
See “Grouping notification devices”, starting on page 87.

Variable Setup
Designate variables to be available in Smart Alec.
Variables represent values that can change at any time.
These values come from data sources external to Smart
Alec, using DDE, OPC, or sockets (see below.) When
there is a change in a variable’s value, actions set up in
Variable Rule Manager (see below) can be triggered and
also where the value of the variable is included in a
message, the value changes. See “Identifying variables”,
starting on page 42.

Variable Rule Manager
Designate rules to govern variables, what is done
with them, and what happens when their values change.
A rule is a pre-defined set of one or more conditions
with possible resulting actions. A rule is associated with
a variable and is implemented when the value of that
variable changes. When the rule is implemented, its
conditions are evaluated. Based on the result of that
evaluation, the rule’s resulting actions may be initiated.
See “Creating variable rules”, starting on page 83.

8

Smart Alec applications

Message Manager
Define messages which can be displayed on
notification devices. Messages can include text, graphics,
formatting, variables, time, date, temperature, and
animation. See “Creating messages”, starting on page 66.

Command Manager
Designate display commands which are used to add,
delete, erase, or replace messages sent to notification
devices. Commands can be triggered by a variable’s
value or can be scheduled for a specific date and time or
for a recurring time period. See “Using commands to
control messages”, starting on page 76.

Display Command Group Manager
Designate logical groups of display commands so
that you can then create another command to essentially
issue a series of commands all at once. See “Grouping
display commands”, starting on page 90.

DDE Data Source Setup
Designate what data will be coming from outside of
Smart Alec using DDE (Dynamic Data Exchange), where
it will come from, and what to do with it. This data can
be used to provide the values for variables. See
“Establishing DDE input data sources”, starting on page
47.

OPC Data Source Setup
Another way, besides DDE, to bring data into Smart
Alec to provide values for variables is by using OPC
(OLE for Process Control). See “Establishing OPC input
data sources”, starting on page 54.

Socket data source setup
Sockets are a third way, besides DDE and OPC, to
bring data into Smart Alec to provide values for
variables. Smart Alec does not have a specific application
for sockets, but there is a process to follow. See
“Importing external data using sockets”, starting on page
64.
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Smart Alec applications

Smart Alec Shutdown
Close all of the Smart Alec applications that do the
background processing. See “Shutting the Smart Alec
system down”, starting on page 33.

System Administration
Used by the system administrator for system-wide or
high-level settings. See “System Administration”,
starting on page 93.

Application Security Setup
There are two applications which can be used to
create a multi-user system with security capability:
Application Security Setup and User Account Security Setup.
Application Security Setup designates what level of
authorization is needed by any user to access specific
applications and the functions in each. If the level of
authorization assigned to a user is greater than or equal
to the level of authorization needed, then access is
granted. See “Authorizing applications and application
functions”, starting on page 108.

User Account Security Setup
In a multi-user system, User Account Security Setup
can be used to designate what level of authorization is
granted to any user for applications, variables,
commands, and notification devices. In other words, you
decide if users can access a given resource (application,
notification device, etc.) and what functions they can do
with it. See “Creating user environments”, starting on
page 102.

Notification Device Interface Setup
Designate the type of hardware the computer uses to
send messages to notification devices. This is usually
done with Notification Device Setup when designating
notification devices, but can also be done separately. See
“Identifying notification device interfaces”, starting on
page 114.

Event Log Manager
View a log of all events that occur in Smart Alec. See
“Managing the log of Smart Alec system events”, starting
on page 119.
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Flowchart for setting up and using Smart Alec
Start

Do you
need a multi-user
system?

Yes
Set up application
authorizations.

No

Page 108

(Application Security Setup)

Set up users.
(User Account Security Setup)

Set up authorization
and ownership options.

Page 102

Page 93

(System Administration)

NOTE: Standard default
options are listed in
“Identifying notification
device interfaces”
starting on page 114.

Do you need
interfaces with nonstandard options?

Yes
Set up notification
device interfaces.

No

Page 114

(Notification Device
Interface Setup)

Set up
notification devices.

Page 38

(Notification Device Setup)

Are you using
real-time data
for variables?

Yes

A

No

B
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A

Do you need
to group variables into
categories?

No

Yes
Set up
variable categories.

Page 93

(System Administration)

Set up variables.

Page 42

(Variable Setup)

Do values for
variables come from
DDE?

Yes
Set up DDE input

No

Do values for
variables come from
OPC?

No

data sources.
(DDE Data Source Setup)

Page 47

Yes
Set up OPC
data sources.

Page 54

(OPC Data Source Setup)

Follow the process
for "Importing external
data using sockets".

B
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Page 64

Flowchart for setting up and using Smart Alec

B

Page 66

Create message(s).
(Message Manager)

Do you need
to send messages to
groups of notification
devices?

No

Yes
Group
notification devices.

Page 87

(Notification Device Group Mgr)

Create/schedule display
command(s) for messages.

Page 76

(Command Manager)

Do you
need to group display
commands?

Yes
Group
display commands.

No

Will a variable
trigger an action?

No

Are you getting
errors or having
other problems?

Page 90

(Display Command Group Mgr)

Yes
Define the conditions
for the action to occur.

Page 83

(Variable Rule Manager)

Yes
Check the event log
(Event Log Manager)

No

Page 119

or contact your
Smart Alec distributor.

End
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What’s new in Smart Alec 3.0
1.

2.

3.

4.

5.

6.

7.

8.
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A separate system administration application is
now available for system-wide or high-level
settings. See “System Administration” on
page 93.
Security has been set so that a single-user system
is the default. You can set up a multi-user system
at any time. To do so, see “System
Administration” on page 93, “Creating user
environments” on page 102, and “Authorizing
applications and application functions” on
page 108.
Interfaces for notification devices do not need to
be set up before the notification devices
themselves. There is one default interface of each
type pre-installed. You can set up others if
needed when you set up a notification device.
See “Identifying notification devices” on page 38
and “Identifying notification device interfaces”
on page 114.
Two types of variable rules have been removed:
Counter Rule and Counter with Alarm Rule. The
functionality for these has been included in the
definition of the variable itself. See “Identifying
variables” on page 42.
OPC (OLE for Process Control) has been added
as a means to import data for variables. See
“Establishing OPC input data sources” on
page 54.
The method for including graphics in a message
has been defined. See “Appendix 5: Including
graphics in Smart Alec messages” on page 138.
The background processors have been
redesigned so that most applications will operate
more quickly.
Reported software inconsistencies have been
resolved for better system performance.

QuickStart: Sending a simple message

Smart Alec basics
QuickStart: Sending a simple message
This section takes you through the process of setting
up the minimum system to accomplish the task of
sending a message immediately from the Message
Manager through a wired connection to an ALPHA sign.
(See “Appendix 2: Types of Notification Device
Interfaces” starting on page 124 for descriptions of
available connections.)
Log into Smart Alec
1. From the Start button, click Programs > Smart
Alec.
2.
NOTE
If you are the first or only person
logging into the system, you will
not see this screen. If you are the
administrator and there are other
users already set up in the
system, accept “Alec” as the
user name with no password,
except if you know the password
is different.

3.

The Smart Alec introductory splash screen will
appear temporarily.
If the Login screen appears, as shown below, fill it
in as appropriate. Then click on the Login button.
(If you don’t know how to fill in this screen,
check with your Smart Alec administrator.)
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Set up a wired connection
4. On the SA Bar, click once on the System Setup bar,
then click once on Notification Device Setup.
System
Setup bar

System
Setup group

5.
Add ALPHA
SA device
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Click on the Add ALPHA SA device button.

QuickStart: Sending a simple message
6.

NOTE:

Fill in a name and description as desired. Specify
the serial address of the sign. Choose “Serial
Interface 1” for the Interface Name. Click the Add
button.
The serial address is displayed when the sign
is powered up. Valid addresses for Smart Alec
signs are 1 through 255. Zero is not a valid
address. Use the hand-held Remote Control to
change the address as needed.

Create a simple message
7. From the System Use group on the SA Bar, click
once on Message Manager. A gray screen, like the
one shown below, will appear the first time you
start Message Manager. After you create one or
more messages, when you start up Message
Manager, it will show a white screen with the first
message in the list of created messages.
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QuickStart: Sending a simple message
8.

Choose File> New.

9.

Enter a name for the message. Click OK.

10. Type the message as shown below.

11. Choose File > Update.
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QuickStart: Sending a simple message
12. You will be prompted to verify that you want to
update this message. Select the OK button.

Run the message
13. From the System Use group on the SA Bar, click
once on Command Manager. A screen like the one
shown below will appear listing any existing
commands. Choose the button for a new
command.

Add a new
command.
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QuickStart: Sending a simple message
14. By either typing or using the drop-down arrows
to select from a list, fill in the information as
shown below for the Line 1 production count on
the Line 1 sign. Click the Destination button to
bring up a list, and select a Destination by
clicking on the Line 1 Destination and then on the
double-arrow button. Then click OK. Leave the
start and end dates as they show on your screen
and also the start time, but specify end time as
three minutes from your current time. See below.

If these appear,
leave them set as
they are for now.

The message is processed immediately and appears
on the sign and runs until the end time.
20
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Starting the Smart Alec system
Logging into Smart Alec
To log into the Smart Alec system:
1. From the Start button, click Programs > Smart
Alec.
2. The Smart Alec introductory splash screen will
appear temporarily.
3. Next, the Login screen will appear, as below.

NOTE:
NOTE
If you are the first or only person
logging into the system, or if
you are the administrator, accept
“Alec” as the user name with no
password.

4.
5.

NOTE:

You will not see this screen if: 1) this is
the first time you’re starting Smart
Alec after installation, or 2) you are the
only user and have no password.

Type in your user name and password, and click
on the Login button.
Processing applications are started and run in
the background as needed. Also, the window
called the SA Bar will appear for your use. (See
“Using the SA Bar” below.)
Even if you click Cancel in Step 3 above, the
processing applications remain running. To
shut them down, log into Smart Alec and click
Smart Alec Shutdown on the SA Bar.
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Using the SA Bar
The SA Bar is where you start all the Smart Alec
applications for which you are authorized.
Close button

Button group bars
Button
group

Authorized
applications

How to use the SA Bar
•

•
•

NOTE:
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Click on any of the button group bars to show
the applications available within that group of
applications. The button group bars slide up and
down as needed to reveal component
applications below each bar.
Click once on any application to start that
application.
Use the Close button to close any currentlyrunning Smart Alec user applications in addition
to closing the SA Bar. See “Shutting the Smart
Alec system down” on page 33.
Background processors will remain running
unless full shutdown procedures are followed.

Starting the Smart Alec system

Smart Alec applications in button group bars
System Setup
•
•
•
•

Notification Device Setup
Variable Setup
DDE Data Source Setup
OPC Data Source Setup

•
•
•
•
•
•

Message Manager
Command Manager
Variable Rule Manager
Notification Device Group Manager
Display Command Group Manager
Smart Alec Shutdown

•
•
•
•
•

System Administration
User Account Security Setup
Application Security Setup
Notification Device Interface Setup
Event Log Manager

System Use

Advanced
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How the Smart Alec windows work
The picture below is representative of the windows
in Smart Alec. The table following indicates its features
and functions.
Duplicate, Update/change, Details/view, and Delete
are described generically below. The New/add Item
function is described in general below, and is described
in detail individually in the section for each Smart Alec
application.
A

B

C D E

F

G

H

I

J

K

Sorting:
You can sort any column of
data by double-clicking on
its heading. The first doubleclick sorts ascending; the
second sorts descending. If
more than one column is
selected, the right-most
column is used for the sort.

L

M
N
O

Feature
A
B

C
D

E
F
G

H
I
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Name
Menu button
New item

Function

Pull-down menu for the application.
Create a new item of this type. The properties will need to be filled in using
the dialog box that appears. The icon for New Item may vary in some
applications, and some applications have more than one type of new item.
Duplicate this item Duplicate the item selected and show its properties so they can be changed
as needed to create another item that is similar to the original.
Update this item
Show all properties for this item so they can be changed as needed.
You can also access the screen to update an item by double-clicking to the
left of the row. (Also see Item selection.)
Details
Show all properties for this item, but do not allow any updating.
Delete this item
Delete this item from Smart Alec.
Locate function
Use this after selecting a column to search for a specific value. Used in
conjunction with Locate value. If more than one column is selected, the rightmost column is used
Locate value
Type the value to search for. Used in conjunction with Locate function.
Minimize button
Put the application down to the Windows task bar.

How the Smart Alec windows work
Feature

Name

J
K
L

Resize button
Close button
Item selection

M
N
O

Right-click
Row height
Column width

Function
Toggle the size of the window.
Close this application.
Click in this column to select the row for an item, or double-click to open the
item. (Also see Update this item.) When a row is selected, you can right-click
on the row to get a pop-up menu for all the file functions (new, update, etc.)
Right-click on the name of the item to create a new item.
Click and drag the bottom edge of the row to adjust the height of the row.
Click and drag the right edge of the column to adjust the width of the column.

The picture below is representative of the add/
update/details dialog boxes in Smart Alec. The table
following indicates its features and functions.

A

B

C

D
Feature

Name

A

Item name

B

Item properties

C
D
E

Drop-down selection
button
Add/Update
Apply

F

Cancel

E

F

Description
Name of the item selected. Cannot be changed after the item is created. If
you need to change it: duplicate the item, change the new item’s name,
then delete the original item.
Must be added, can be updated with proper authorization, can not be
updated in details mode. Completion of these properties can be by
typing, or, in some cases, by using a Drop-down selection button.
NOTE: Single quotes, such as in the middle of “John’s sign” to show
possession, can not be used.
Allows selection of items already created.
Adds or updates this one item and exits this window. (N/A for details.)
Allows you to save the values for this item and then view/update the
values for any other item of the same type. (N/A for details.)
Exits this window without making any changes.
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How Smart Alec uses variables
Variables are entities used in Smart Alec to represent
values that can change at any time. The values can come
from a number of places, such as a production line, a
spreadsheet, and others. Some examples of variables are
temperature, production speeds, counts, on/off settings,
alarms, and security lock status. (See “Identifying
variables” on page 42 for detailed instructions.)
SALES NEWS
Sales today: $12,345

In this example, the amount of
sales (12,345) is the variable.

Rules (pre-defined conditions with resulting actions)
can be set for governing what happens when the value of
a variable changes.
Smart Alec constantly monitors variables for a
change in their values. When there is a change, any rule
associated with that variable will be analyzed and its
actions may be triggered. Examples of possible actions
include starting or stopping a message and updating the
value of a variable if it is included in any message. (See
“Managing the log of Smart Alec system events” on
page 119 for detailed instructions.)
One of the most important concepts to understand is that
you can use variables and variable rules to control things that
happen in Smart Alec. Both a variable and a rule controlling
the results of a change in its value can trigger an action in
Smart Alec.
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Working with Smart Alec application components
The functions for Duplicate, Update, Details, and
Delete are similar in each Smart Alec application. This
section describes these functions generically, using the
Variable Rule Manager as an example for the application
items.
Where an application’s function differs from these
generic functions, it is described in a section for that
application. The function for Add is described for each
application and gives explanations for all properties for
the item being added.

Duplicating an item
NOTE
Since you can’t change the name
of an item with the Update
function, use duplicating to
rename an item:
1. Create a copy.
2. Rename it.
3. Delete the original.

You can duplicate any item and change the name and
any properties.
1. Highlight the row for the item to copy. Then
either choose File > Duplicate, click the Duplicate
button, or right-click on the row and select
DupLicate….
Duplicate button

Click in this column to
select an item.
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2.

The window for adding an item will appear.
Change the name of the item and any properties
that are different.

3.

Then click either Add or Apply. Clicking the Add
button takes you out of the window for adding
an item, and the new item is shown in the list.
Clicking the Apply button adds the new item into
the list, but leaves the dialog box open for
additional editing if needed. To close the dialog
box after using Apply, choose Add or Cancel. You
will only see the new item in the list when you
exit the window for adding an item, with either
Add or Cancel.

Working with Smart Alec application components
4.

When the main window is displayed again, the
new item is in the list.

1.

Highlight the row for the item to change. Then
either choose File > Update, click the Update
button, or right-click on the row and select
DupLicate…

Changing an item

Update button

Click in this
column to
select an item.
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2.

Make your changes. Then click Update.
You can not change the item’s Name here.
You can change anything else.

You can change more than one item in sequence this way:
1. Make the changes in the first item.
2. Click Apply.
3. Choose another item using the Name drop-down arrow.
4. Make changes in the new item.
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Viewing details of an item
1.

Highlight the row for the item to change. Then
either choose File > Details, click the Details
button, or right-click on the row and select
Details…

2.

The Details screen will appear. This simply
shows the settings for the item. You can not
change any of the settings here.

Details button

Click in this
column to
select an item.

You can choose
another item by
using the Name
drop-down arrow.
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Deleting an item
1.

Highlight the row for the item to change. Then
either choose File > Delete, click the Delete button,
or right-click on the row and select Delete.

2.
3.

You will be asked if you want to delete this item.
Choose Yes to delete the item.

Delete
button

Click in this column to
select an item.
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Shutting the Smart Alec system down
From time to time, you may wish to shut down all or
part of the Smart Alec system based on your own
circumstances.
However, under the following conditions, you must
shut down the Smart Alec system and then restart it
before you can use the change:
1. After adding a notification device
2. After adding a notification device interface
3. After losing a connection to a device
4. After adding a DDE or OPC input data source
You do not need to shut down and restart Smart Alec
under these conditions:
1. Adding or changing a variable
2. Adding or changing a message
3. After losing a connection to a DDE input data
source

Individual user applications
To close any individual user application for setup
and management of the system, use any of these
methods:
• Click the Close button, available for all Smart
Alec applications.
• Choose Exit from the application’s File menu.
• Press Alt+F4.
File menu
Close
button
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All background processor applications
To close all of the Smart Alec applications that do the
background processing, click Smart Alec Shutdown in the
System Use button group on the SA Bar.

NOTE:

Running Smart Alec Shutdown will stop all
processing of messages and commands!

In Windows, you can see which programs are running
by pressing Ctrl/Alt/Del together, but then be sure to
choose Cancel here rather than End Task or Shut Down.
Also be sure you don’t press Ctrl/Alt/Del twice,
rebooting the computer.
To restart the background processors, from the Start
button, click Programs > Smart Alec.

All setup and manager user applications
To close all of the currently-running Smart Alec user
applications for setup and use of the system (found in the
SA Bar), close the SA Bar by any of the following
methods.
NOTE:
•
•
•
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This will not close the Smart Alec background
processor applications. (See the prior section.)
Choose Close on the SA Bar menu.
Click the Close button on the SA Bar.
Press Alt+F4.

Shutting the Smart Alec system down
SA Bar menu button
Close
button

Complete Smart Alec system
1.
2.

Click Smart Alec Shutdown on the SA Bar.
Close the SA Bar.
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Overview

Setting up the Smart Alec system
Overview
Typically, Smart Alec is used by only one person in
an organization. Even if there is more than one person
using Smart Alec, all users can be set up to have full
access rights to all applications, application functions,
and system inputs and resources. This setup is called a
“single-user” system.
However, if there is more than one person using
Smart Alec, your system may require security to be set so
some users have limited usage and others have unlimited
usage of Smart Alec. This setup is called a “multi-user”
system. In a multi-user system, those users with limited
usage of Smart Alec generally can only access
applications for using the system, not those for setting up
the system.

Setting up the Smart Alec software

NOTE
Default settings are provided for
each system resource, user, and
application.

A number of things must be set up in the Smart Alec
environment for first-time use:
• Identify system resources (notification devices,
notification device interfaces, and variables and
possibly variable categories.)
• Establish input data sources, such as DDE, OPC
or sockets.
Also, if this is a multi-user system:
• Create user environments.
• Authorize applications and application functions
for each user.
The sections following explain what must be done.
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Identifying notification devices
Notification Device Setup is used to designate the
names and properties to be used for places where
messages will be displayed (i.e., signs, pagers, and
email).
Notification devices have properties. Examples of
some properties that may be required are:
• Device name
• Description
• Address
• Notification device interface to use
• Pin number
• Packet size
• Authorization level

Accessing the Notification Device Setup application
From the System Setup group on the SA Bar, click
once on Notification Device Setup. A screen like the one
shown below will appear, listing any existing notification
devices.

This column is available
only if activated by the
Smart Alec administrator.
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Adding a notification device: ALPHA, pager, email
1.

Add ALPHA SA
device

Choose the correct button for the type of
notification device you wish to add.

Add pager
device
Add email
device

2.

For this example, we will add an ALPHA SA
sign with a direct serial interface connection, as
shown here. See the table below for explanations.

A
B
C
D
E

F
G

Item
A
B
C

Name
Name
Description
Address

Description
Name of the device as it will be known.
Description of the device, for clarity. (Optional)
Serial address assigned to the ALPHA SA sign. This is displayed when the sign is
powered up and is set with a Remote Control. Zero is not a valid address.
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Item

Name

D

Interface name

E

Additional properties

Description
Specific notification device interface to use with this notification device. The list of
available interfaces includes those that are already set up and also those types of
interfaces that can be set up (serial on specific COM ports, pager local on specific
COM ports, pager wide area, or terminal server). If an interface is not already set up,
it will be set up automatically, using defaults, when the notification device is added.
Depending on the type of notification device interface chosen, there may or may not
be other properties to specify. These properties are set when a new notification
device interface is set up. Some properties may be changed when a new notification
device is set up. (To change notification device interface properties after set-up, see
“Identifying notification device interfaces” on page 114.)
Serial has no additional properties.
Additional properties for local pager:
• Pin # (Pager identification number)
• Packet size (Contact your network administrator to determine this.)
Additional properties for wide-area pager:
• Pin # (Pager identification number)
• Packet size (Contact your wide-area paging service to determine this.)
NOTE: A wide area pager needs an attached modem.

F

Authorization level

G

Advanced

Additional properties for Terminal Server:
• IP address (Internet Protocol address assigned to the terminal server)
• Port Number (Must be 3001 if the terminal server is an Alpha Ethernet Adapter.)
Authorization level a user would need to access this notification device.
(Available only if activated by the Smart Alec administrator.)
Choose this button for more advanced functions. Only available for use with serial
interfaces. See the next step.

3.

For a new serial ALPHA SA notification device,
the Advanced button is for these properties.

A
B

Item
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Name

A

Message confirmation

B

Time Out

Description
When Message Confirmation is enabled, the sign sends a response to the sender to
confirm that the message has been received.
The time, in seconds, to get a response from the device before timing out. (The
Message Confirmation must be enabled.)

Identifying notification devices

Settings for additional notification devices
In addition to the ALPHA SA device illustrated
above, the settings below are available for pager and
email devices.

Pager device
Item

Name

A
B
C

Name
Description
Interface name

D
E

Pin #
Packet size

F

Notification device
authorization level

Description
Name of the device as it will be known.
Description of the device, for clarity. (Optional)
Specific notification device interface. The only types available are pager local or
pager wide area.
Pager identification number
For details, refer to the documentation for the pager or contact your network system
administrator or wide-area paging service to determine this.
To change this for an interface that’s already set up, use Notification Device Interface
Setup.
Authorization level a user would need to access this notification device.
(Available only if activated by the Smart Alec administrator.)

Email device
Item
A
B
C
D

Name

Description

Name
Description
Email address
Interface name

Name of the device as it will be known.
Description of the device, for clarity. (Optional)
Destination address for the email message
Specific notification device interface. To create a new interface for email, choose
“Mapi Server”. A new interface will be created using a name composed of the Email
profile plus “Profile”. For example, the interface for an email user named Joe would
be called “Joe Profile”.
E
Email profile
The network system name of the person to receive the email messages.
F
Email password *
The authorized password belonging to the Email profile.
G
Confirm new password * Repeat the Email password, for confirmation.
H
Notification device
Authorization level a user would need to access this notification device.
authorization level *
(Available only if activated by the Smart Alec administrator.)
* Only available when setting up a new email interface.
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Identifying variables
Variable Setup is used to designate real-time (“as it
happens”) variables to be available in Smart Alec.
Variables represent values that can change at any time.
The values for the variable can come from a number of
places outside of Smart Alec, such as a production line, a
spreadsheet, manual data entry, and others. (For a more
complete definition of variable, see page 163.)

Accessing the Variable Setup application
From the System Setup group on the SA Bar, click
once on Variable Setup. A screen like the one shown below
will appear, listing any existing variables.

NOTE:
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If you delete a variable which receives its value
from an OPC data source, be sure to also delete
the link to that OPC data source.

Identifying variables

Adding a variable
1.

Choose the button to add a new variable.

Add a variable

There are three tabs on the screen for adding a
variable: “Details”, “Presentation”, and “Security”. (The
“Security” tab is only available if activated by the Smart
Alec administrator.) For this example, we will add a
variable called “Speed-Line 1”, as shown here. See the
table below each tab’s picture for explanations.
2. Complete the “Details” tab to set up basic
information for the variable.

A
B

G

C
D
E
F

Item
A
B
C

Name
Name
Description
Category

Description
Name of the variable as it will be known
Description of the variable, for clarity (Optional.)
User-defined category for the variable (Optional.) (Available only if activated by the
Smart Alec administrator.)
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Item
D

E
F

F

44

Name
Padding

Description

Determines the positioning and any fill characters for the value of the variable within
a message.
• Leading Spaces: Value is right-justified, filled with spaces (blanks) in front of the
value.
• Leading Zeros: Value is right-justified, filled with zeros in front of the value.
• None: Value has no padding. Any extra spacing between the message and the
variable’s value is deleted.
• Trailing Spaces: Value is left-justified, filled with spaces (blanks) after the value.
Number of characters to be Sets the length to be allocated for the value of the variable when used in a message.
displayed
Maximum number of characters to allow for the length of the variable to display
Number of digits after
Sets the level of precision for fractional numbers
decimal point
If the value for the variable has a decimal, the Number of digits after decimal point
indicates how many decimal places to use in the value for the variable. (For example,
if the value for the variable has 5 characters with a Number of digits after decimal
point of 2, then the number “123.456” would be displayed as “123.45”. If the value
for the variable has 6 characters with a Number of digits after decimal point of 4, then
the number “123.456” would be displayed as “?3.456?”.) NOTE: The Number of
digits after decimal point setting is only available if the Data Type of the variable is
float. Otherwise, you will not see this setting.
Data Type
Format of data for the variable:
• Integer: a whole number (with no fraction)
• Float: any number other than an integer. Can include decimals.
• String: text, including alphabetic, numeric, and other characters

Identifying variables
3.

Complete the “Presentation” tab to indicate how
the variable will appear in a message on a sign.
The Low Range and High Range sections are
optional.

A
B
C
D

E
Item

Name

A

Trigger Variable

B
C

Limit
Color

D

Flashing

E

Low Range
settings

F

G
Description

The variable to be used as the basis for setting range limits. The trigger variable
defaults to the variable being set up. You can choose a different variable from the list
to use as the trigger. Choosing a different variable would indicate that the value of the
other variable is to be used as the trigger for the evaluation, but the value of the
variable being set up is to be displayed.
Limit/threshold between this (high or low) range and the normal range
Color to use for displaying the variable. “Default” uses whatever color state is set for
the message immediately preceding the variable.
Whether or not the variable will flash. “Default” uses whatever flashing state is set for
the message immediately preceding the variable.
(Optional) For a range lower than normal:
• Whenever the value of the trigger variable is equal to or lower than the value set
here, the variable will be displayed using the color and flashing settings for this
low range.
• Color to use for displaying the variable when in the low range
• Whether or not the variable will flash when in the low range
• “Default” uses whatever color or flashing state is set for the message immediately
preceding the variable.
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Item

Name

F

Normal
settings

G

High Range
settings

Description
For the normal range:
• If Low Limit and/or High Limit are set, whenever the value of the trigger variable is
higher than the low limit and/or lower than the high limit, the variable will be
displayed using the color and flashing settings for this normal range. If no limit is
set, color and flashing for the normal range apply to any value.
• Color to use for displaying the variable when in the normal range
• Whether or not the variable will flash when in the normal range
• “Default” uses whatever color or flashing state is set for the message immediately
preceding the variable.
(Optional) For a range higher than normal:
• Whenever the value of the trigger variable is equal to or higher than the value set
here, the variable will be displayed using the color and flashing settings for this
high range.
• Color to use for displaying the variable when in the high range
• Whether or not the variable will flash when in the high range
• “Default” uses whatever color or flashing state is set for the message immediately
preceding the variable.

4.

Complete the “Security” tab if your Smart Alec
system is using Authorization Levels. This tab
will not be present if the administrator has not
set Authorization Levels on. (Refer to
“Components of the System Administration
window” on page 94.)

A

Item
A

Name
Authorization Level

Description
Security level needed to use the variable. Default is 5.

5.
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When all values are set, click Add (or Apply) and
the new variable is displayed in the list of
variables.

Establishing DDE input data sources

Establishing DDE input data sources
DDE Data Source Setup is used to designate what data
will be coming from outside of Smart Alec using DDE
(Dynamic Data Exchange), where it will come from, and
how you want to use it. The link to this data is used to
provide values for variables.
Smart Alec acts a DDE client. It needs a DDE server
to communicate with in order to provide values for
variables. Many existing programs already function as
DDE servers, such as Wonderware’s Intouch and
Microsoft Excel. To use these or any other DDE-server
applications with Smart Alec, you must use the service,
topic, and item names which are to supply values for the
variables from the DDE server. The DDE server
application’s documentation should provide these. (The
discussion in the following sections uses Microsoft Excel
as an example.)
After you establish a connection with the DDE
server, the DDE server sends the value of the item to
Smart Alec each time the item changes value.
NOTE:

When using DDE, Smart Alec must be
installed on the same computer as the external
data source. When using NetDDE, Smart Alec
must be installed on the same network as the
external data source. In both cases, the source
must be Windows-based.
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Accessing the DDE Data Source Setup application
From the System Setup group on the SA Bar, click
once on DDE Data Source Setup. A screen like the one
shown below will appear, listing any existing DDE data
sources.

Adding a link to a DDE data source
1.

Add a DDE
data source.
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Choose the button to add a new DDE data
source.

Establishing DDE input data sources
2.

For this example, we will add a link to a Microsoft
Excel spreadsheet as DDE data source. See the
table below for explanations.

A
B
C
D
E
F
G
H
I

Item

Name

A

Smart Alec Variable to
Update

B

ASCII printable checkbox

C

Server path

Description
The variable in Smart Alec for which this data will supply the value. The variable is
automatically filled in with the last entry that was used. The variable must first be
established before it can be selected here, but you can establish a new variable with
the New button. See “Identifying variables” on page 42.
ASCII control codes (non-printable characters) will be deleted before sending the
data on to Smart Alec, leaving only data that is valid for presenting on a notification
device. Valid only for a variable of “string” type.
NOTE: All DDE data is restricted to 125 characters. If the value is longer, it will be
truncated (cut off) to 125.
The full path to the file (or application, if not a specific file) for the DDE data source
supplying the data. Smart Alec uses the server path to automatically start the server
when Smart Alec starts. The server path is not mandatory if the server is always
running before Smart Alec starts.
If you’re using NetDDE with a source on a computer other than the one where Smart
Alec is running, you do not need to include the server path, since Smart Alec can not
start a source on a different computer. Therefore, when using NetDDE, the DDE
server application must be running before the DDE link can be active. See
“Accessing DDE input data” below.
If the server is an application for which you have a specific file to use, you can
include the full path to and including the file, in quotes, after the full path to the
application, not in quotes. In this example, the server path is: C:\Program
Files\Microsoft Office\Office\Excel.exe “C:\My Documents\Fiscal Report.xls”. The
effect of this is that when Smart Alec is started, both the server and the specific file
are automatically started along with Smart Alec.
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Item
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Name

D

Service

E

Topic

F
G

Item
Default Value

H

Filter On checkbox

I

Delta Value

Description
Name of the application (not file) the data comes from. This may or may not be an
executable program. Refer to the documentation or software vendor for your DDE
server application to determine the correct service for that application.
In this example, the service identifies the Excel application.
Refer to the documentation or software vendor for your DDE server application to
determine the correct topic for that application.
In this example, the topic identifies the specific worksheet within the Excel workbook
specified in the Server Path.
The specific piece of data to be used. In this case, the cell (row and column) is used.
The value to be used for the variable when none is supplied by the DDE data link,
such as if the DDE server stops running for any reason. Any values can be used if the
data type is string. Any numeric values can be used for integer or float, but
alphabetic and other special characters can not be used.
Indicates that you want to filter the DDE data with a Delta Value. If you do not check
this on, Smart Alec will update the value of the variable whenever the value changes,
however small that change is. This may cause more processing than you want.
Checking the Filter On checkbox and setting a Delta Value limits updating of the
variable to when the change is greater than the “plus or minus” range. (NOTE: Some
DDE server applications, such as Microsoft Excel, update all values whenever any of
the values change.)
The number that is used to set a “plus or minus” range for the value of the variable.
(So if the current value of the variable is 5 and the Delta Value is 2, then the range
would be from 3 to 7.) The value of the variable is compared with this range. If the
value of the variable is outside the range (higher or lower), then that value of the
variable is used to update the variable wherever the variable is used for a command.
Otherwise, the value of the variable is not updated.

Establishing DDE input data sources

An example using a Microsoft Visual Basic application
Below is an example specifying a Visual Basic
application which processes data and provides that data
directly to Smart Alec.

Setting
Smart Alec Variable to Update
ASCII printable checkbox
Server path
Service
Topic
Item
Default Value
Filter On checkbox
Delta Value

Value
Hammer 1 pressure
[N/A]
C:\Program Files\HighLevelTest.exe
C:\Program Files\HighLevelTest.exe
Topic5
Label1
0
[off]
[N/A]
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An example using a Microsoft Access application
Below is an example specifying a Microsoft Access
application which processes data and provides that data
directly to Smart Alec.

Setting
Smart Alec Variable to Update
ASCII printable checkbox
Server path
Service
Topic
Item
Default Value
Filter On checkbox
Delta Value
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Value
Sales this month
[N/A]
C:\Program Files\Microsoft Office\Office\MSACCESS.EXE
MSAccess
Sales.mdb;SQL select Sales_This_Month from Sales_Table where Product = Widget
data
0
[off]
[N/A]

Establishing DDE input data sources

Accessing DDE input data
When running and accessing a valid DDE source,
DDEInputHandler.exe feeds data to the Smart Alec
system and variables are updated.
For accessing DDE input data, DDEInputHandler
must be running. (See “All background processor
applications” on page 34.) When the Smart Alec system
is started, DDEInputHandler.exe is started automatically
and it starts the service application(s) that have been
established. It tries to connect to the specified topics. Let
Smart Alec start DDE server applications, since there will
be a conflict if they are started before starting Smart Alec.
If you want to shut down and restart Smart Alec, you
do not need to shut down DDE server applications which
were originally started by Smart Alec, asf5.3972 0 TD(Ó)Tn you
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Establishing OPC input data sources
Introduction
OPC Data Source Setup is used in Smart Alec to
designate what data will be coming from outside of
Smart Alec using OLE for Process Control (OPC), where
it will come from, and how you want to use it. The link to
this data is used to provide values for variables.
Smart Alec acts an OPC client. It needs an OPC
server to communicate with in order to provide values
for variables. Many existing programs already function
as OPC servers, such as Cimplicity, Steeplechase Visual
Logic Controller, or Iconics. To use these or any other
OPC-server applications with Smart Alec, you must
specify the OPC server and item names which are to
supply values for the variables. The OPC server
application’s documentation should provide these.

General steps for communications using OPC data sources
In general, the steps for using OPC data servers with
Smart Alec are as follows:
1. Be sure the OPC data server is installed and
registered. When running and accessing a valid
OPC source, it feeds data to the Smart Alec
system and variables are updated. (Even if the
OPC data server is installed and registered on a
different computer, it must also be registered on
the Smart Alec computer. Otherwise, you will be
able to choose the OPC links to use in Step 3 but
it won’t work.)
2. Start and log into Smart Alec.
3. Establish the specific OPC links to use between
Smart Alec and the external server. See the
discussion below.
4. Smart Alec requests the data periodically.
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Accessing the OPC Data Source Setup application
From the System Setup group on the SA Bar, click
once on OPC Data Source Setup to display a screen like the
one shown below, listing any existing OPC data sources.

NOTE:

If you delete a variable which receives its value
from an OPC data source, be sure to also delete
the link to that OPC data source.
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Adding a link to an OPC data source
1.

Choose the button to add a new OPC data source
(or choose File > New.)

2.

For this example, we will add a link to specific
pump speed data coming from an OPC server on
a networked computer. See the table below for
explanations.

Add an OPC
data source.

A
B
C
D
E
F
G
H

Item
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Name

A

Smart Alec Variable to
Update

B
C
D

OPC Server
Item
Default Value

Description
The variable in Smart Alec for which this data will supply the value. The variable is
automatically filled in with the last entry that was used. The variable must first be
established before it can be selected here, but you can establish a new variable with
the New button. See “Identifying variables” on page 42.
NOTE: The same OPC server/item can be used to update more than one variable by
creating more than one link.
Name of the OPC server sending the data, as well as the computer location if remote.
The specific source of data to be used.
The value to be used for the variable when none is supplied by the OPC data link,
such as if the OPC server stops running for any reason.
Can be any alphanumeric value/string.

Establishing OPC input data sources
Item

Name

E

Filter On

F

Delta Value

Description
Indicates that you want to filter the OPC data with a Delta Value. If you do not check
this on, Smart Alec will update the value of the variable whenever the value changes,
however small that change is. This may cause more processing than you want.
Checking the Filter On checkbox and setting a Delta Value limits updating of the
variable to when the change is greater than the “plus or minus” range. To limit
processing, you can also use the Update Rate and Dead Band by clicking the
Advanced button, described below.
The smallest amount of change (“plus or minus”) necessary for a variable to be
processed by Smart Alec. Similar to Dead Band, but is expressed as a specific
number, applies to the Smart Alec server and to only one variable. (The Filter On box
must be checked for Delta Value to be available.)
The Delta Value number is used to set a range for the testing the value of the variable.
The prospective value of the variable is compared with this range. If the value of the
variable is outside the range (higher or lower), then that value is used to update the
variable wherever the variable is used. Otherwise, the variable is not updated.

G

In Service

H

Advanced

Example: If the current value of the variable is 5 and the Delta Value is 2, then the
range would be from 3 to 7. If the OPC server sends a value of 8, Smart Alec will
update the variable. If the OPC server sends a value of 6, Smart Alec will not update
the variable.
Indicates that the OPC server and item are to be considered active.
If you have In Service un-checked, you can use OPC Data Source Setup to set up the
server and item before they are actually active. Later, when they are validly active,
return to this screen and make In Service checked. The OPC server and item will be
recognized by Smart Alec automatically.
Allows you to modify the Update Rate and Dead Band, which are properties for the
entire group of OPC tags for Smart Alec. (See page 62.)
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3.

You can browse the network to select an OPC
server and desired item. When the server and
item are found, OPC considers an item to be a
“tag” until the server and tag are connected to
the Smart Alec system.

NOTE:

You need to have Microsoft Internet Explorer 4.0
or higher installed to use this function.

These
buttons are
not used by
Smart Alec.

These columns
are not used
by Smart Alec.
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4.

When you locate the tag, highlight it and click
OK. In this example, “\\” indicates that the
server is on a remote computer, not the local
computer where Smart Alec is running. Use care
when typing the server name in by hand instead
of browsing for it.

Filter allows you to use
“wild card” (* and ?)
characters to limit the
list of available tags.
For example, you could
limit the list of tags
shown here to only
Ramp1 through Ramp5
by using a filter of
“Ramp*”. Since only
“*” is used here, all
values are listed.

After clicking OK above,
the Add OPC Link
window shows Server
and Item filled in.
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5.

1

Select Add after
completing the
information for
the new variable.
You can then
choose that
variable, as
shown below.
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Next, choose a Smart Alec variable to associate
with the OPC tag for updating. If you need to
create a new variable, either 1) right-click on the
Smart Alec Variable to Update and then choose Add
Variable on the pop-up menu, or 2) click on the
New button.
2

Establishing OPC input data sources
6.

Complete the Default Value. Also, if you need to
provide a Delta Value for numeric variables,
check the Filter On box and then fill in the Delta
Value.

7.

Advanced functions apply to the entire group of
Smart Alec OPC links to this OPC server. When
you change these, you are asked to confirm the
change. See the picture and table below for
explanations.
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A
B

Advanced OPC
properties:
Don’t delete
this! It’s used
for a crossreference.

Item
A

B

Name
Update Rate (ms)

Dead Band (%)

Description
The interval time, in milliseconds, for the OPC server to wait before updating the
values of all the items in the entire Smart Alec group.
In the example above, the updates would occur every 1000 milliseconds, which is
once a second.
The smallest percentage of change necessary for variables to be sent to Smart Alec
by the OPC server. Similar to Delta Value, but is expressed as a percentage, applies
to the OPC server and to all numeric variables in the Smart Alec group.
Example: If the Dead Band is zero percent, the OPC server will not filter out any data,
thus sending all data to Smart Alec. If the Dead Band is 50 percent, the OPC server
will send changes for tag/items only if their values have changed by more than 50%.
If the Dead Band is 100 percent, the OPC server will filter all data, thus sending none
to Smart Alec.
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8.

When all values are set, click Add (or Apply) and
the new OPC link is shown in the list of links.
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Importing external data using sockets
Sockets are a way (besides DDE and OPC) to import
data into Smart Alec from external data sources, using a
client/server relationship.
NOTE:

There must be a user with a password in order
to send data to Smart Alec using sockets. For
information on how the user and password are
used, see “Login Sequence” on page 141. For
setting up users with passwords, see “Creating
user environments” on page 102.

General steps for communications using sockets
In general, the steps for using sockets with Smart
Alec are as follows:
1. Start and log into Smart Alec. See “Logging into
Smart Alec” on page 21.
2. Establish the specific computer port number to
use between Smart Alec and the external system.
See “Setting the port number” below.
3. Initiate a socket connection between the systems.
4. Send data from the external data source to Smart
Alec. For detailed instructions on using sockets
to send data into the Smart Alec system, please
see “Appendix 6: Socket Interface” on page 140.

Setting the port number
1.
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From the Advanced group on the SA Bar, click
once on System Administration. A screen like the
one shown below will appear.

Importing external data using sockets

2.

The default port number for the Socket Handler
connection is 8150. If you wish, you can type a
different port number. Valid port numbers are
1025 and higher.

3. Click OK.
For more detailed information about using sockets
for Smart Alec data, see “Appendix 6: Socket Interface”
on page 140.
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Managing the Smart Alec system
When using the Smart Alec system, you can:
• Create messages.
• Create and schedule commands for messages.
• Create rules for variables.
• Group notification devices and display
commands.

Creating messages
A message is a unique, unified set (file) of
information – a “thought”. It can be saved and/or sent to
a notification device. Its “look and feel” is based on that
specific device.
A message is defined using the Message Manager. It
may include some or all of the following properties,
either specified or defaulted:
• Text
• Formatting (modes, spacing, justification, font,
color, width, height, flashing, true descenders)
• Objects (time, date, animation, temperature,
counter)
• Variables
• Graphics (See “Appendix 5: Including graphics
in Smart Alec messages” on page 138.)
A message does not include the following, which are
designated using Command Manager for the message:
• Scheduling
• Destination
• Execution or Run Priority
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Accessing the Message Manager application
From the System Use group on the SA Bar, click once
on Message Manager. A gray screen, like the one shown
below, will appear the first time you start Message
Manager. After you create one or more messages, when
you start up Message Manager, it will show the first
message in the list.

NOTE:

When you first create messages and the
commands for them, you may want to practice
with a few messages to achieve different
effects on the notification device. You can use
the preview function, described starting on
page 70, for this.
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Components of the Message Manager window
The picture below is representative of the Message
Manager window. See the table below for explanations of
the components.
A B C

D

E

F

G

H

I

J

K

L

M

N

O

P

Q

R

Item
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Name

A
B
C

Message name
Message selection
Preview button

D

Mode button

E
F
G

Mode pause (speed)
button
Justification button
Fonts button

H
I
J
K

Color button
Width button
Height button
Flash button

S

T

U

Description
Name you want to give to the message.
Drop-down box to select from the full list of created messages.
Allows you to send the current message to the sign to see how it will appear. This
temporarily overrides any other messages on the sign.
Allows you to set modes, which are special effects that change the way a message
appears on a sign, and the position of a message on the sign. Mode should always
be the first setting in a message.
Allows you to set the length of time to pause before repetition of this message.
Allows you to set character spacing and left-, center-, or right-justification.
Allows you to select the font and the number of LED rows to use for characters that
follow.
Allows you to set the color to use for whatever follows.
Allows you to set characters that follow to display as wide or double-wide.
Allows you to set characters that follow to display as double-high or not.
Allows you to turn flashing on or off for whatever follows this control, until changed
by another Flash control.

Creating messages
Item
L

M
N
O
P
Q
R
S
T
U

Name

Description

True descenders button

Allows you to indicate that characters that follow are to be displayed using true
descenders, so that, for instance, the tail of a “g” drops below the main base line of
text.
New line/New page button Allows you to indicate that whatever follows is to go on the next line or the next page
of the sign.
Object button
Allows you to insert time, date, animation, and temperature. (Counter is also an
option, but it is not used in the Smart Alec system.)
Variable button
Allows you to insert a placeholder for an existing variable.
Close box
Not available.
Message area
Area for message text, variables, etc., as well as controls for the message and its
contents.
Status bar
Indicates current status and error messages.
Cursor position indicator Shows the position of the cursor in the message.
Date indicator
Shows the current date.
Time indicator
Shows the current time.

Creating a new message
1.
2.

Choose File > New.
Enter a name for the message. Click OK.

3.

Use the Message Manager buttons and their
pop-up screens to define the formatting and
components of the message. An example is
shown below.
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Mode

Mode
pause

Justification Font Color

Text

Variable

4.
5.

Choose File > Update.
You will be prompted to verify that you want to
update this message. Select the OK button.

1.

Click on the Preview button.

2.

This gives a list of notification devices available
for previewing. Messages can only be previewed
on ALPHA SA signs. Choose the sign to which

Previewing a message
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you want to send the message. Then click on the
Send button.

3.

The message will appear on the chosen sign,
temporarily overriding any other messages.
When you are done previewing the message,
click the Done button. Any other messages will
resume display.

1.

Click on the message selection drop-down box.

Selecting a different message
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2.

This gives a list of all the messages available.
Click on the message you want to edit.

3.

The message you choose is shown in the
message name box and the message area.

1.
2.
3.
4.

Select the message to be changed.
Make the changes you need.
Choose File > Update.
You will be prompted to verify that you want to
update this message. Select the OK button.

1.
2.
3.

Select the message to be deleted.
Choose File > Delete.
You will be prompted to verify the delete.

Changing a message

Deleting a message
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4.

The message will be deleted and the next
message in the list will be displayed in the
Message Manager.

Displaying a message on a notification device
To actually display a message on a notification
device, there must be a command for it and it must be
scheduled. See “Using commands to control messages”
on page 76.

Changing a message while it is being displayed
If a message is changed while it is being displayed, it
will be displayed as changed under these conditions:
a. If the command for it is time/date-based, the
message will be displayed as changed after its
command is deleted from and resent to the
notification device with Command Manager.
b. If the command for it is based on a variable, the
message will be displayed as changed after a
change in the value of the variable.

Checking the message syntax
“Syntax” refers to the construction of words, phrases,
sentences, formatting codes, or messages according to
established rules. The construction must be correct for a
message to be displayed correctly. The Message Manager
can check the syntax of messages for you. Follow the
steps below to determine and fix any errors.
1. As an example, say you accidentally deleted the
name of a variable to be used in a message.
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2.

Choose Tools > Message Syntax Check.

3.

If there are errors, as there are here, a window
will show the cursor position of the start of the
error and when the process is complete.

4.

Place the cursor in the message where indicated
by the column number and message statistics.

5.

Determine the error and correct it. It may be
more efficient to delete the variable information

Creating messages
and re-enter it, since Smart Alec is sensitive to
spelling.

6.

When there are no errors in the message, the
syntax check so indicates.
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Using commands to control messages
A display command is used to control messages on a
notification device. On notification devices, a display
command can:
• Add a single message
• Delete a single message
• Erase all messages from the display
• Replace all messages with a single message
A display command can be implemented by
scheduling it for a specific date and time or for a
recurring time period. Scheduling is discussed below in
this section.
A display command can also be implemented by
setting up a Display Command Rule so that the value of
a variable will trigger the command. See “Adding a
display command rule” on page 84.

Accessing the Command Manager application
From the System Use group on the SA Bar, click once
on Command Manager. A screen like the one shown below
will appear listing any existing commands.
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Adding a command
1.

Choose the button to add a new command.

2.

This example creates a command to add the
message for the Line 1 production count on the
Line 1 sign. The table below and the next steps
explain each item and how to create it.

Add a
command.

A
B
C
D
E
F
G
H
I
J
K

L
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Item

Name

A
B
C

Command Name
Description
Action

D
E

Message Name
Execution Priority

F

Run Priority

G
H
I

Destination button
Destination
Owner

J

Schedule Command
checkbox
Schedule Information
Recurrence button

K
L

Description
Name of the command.
A more complete explanation of the command. (Optional)
What you want to be done with the message(s):
• Add a single message to the queue of all messages.
• Delete a single message from the queue of all messages.
• Erase all messages from the display.
• Replace all messages with the single message specified.
Select a message for the action. Valid for all Actions except “Erase all messages”.
The level of authority needed by a user to execute this command. The range of
authority available to a user is determined by the Smart Alec administrator using
User Account Security Setup. (Available only if activated by the administrator.)
The priority of this command on the display, to be compared with other commands
being executed on that display. For example, a message with a Run Priority of 5 will
override a message with a Run Priority of 6. (Available only if activated by the
administrator.)
Click this to bring up a list of available notification devices to select from.
The list of one or more notification devices selected for executing this command.
Specify who can access and use this command. (Available only if activated by the
administrator.)
• Public: This command can be used by anyone. Use this in a single-user system.
• Private: This command can only be used by the person who created it. Use this
only in a multi-user system.
Check this on if you want to specify a time frame for this command. (Optional)
Allows you to set the start date and time and end date and time.
When the command is scheduled, you can click this button to bring up the options
for repeating this command. The options are:
• Daily (every x number of days or every weekday)
• Weekly (every x number of weeks on specific days)
• With an end date (none, after x number of occurrences, or by a specified date.)

3.
4.
5.
6.
7.

Specify the Command Name and Description.
Choose an Action from the available options in
the drop-down list.
Choose a Message, if applicable, from the
available options in the drop-down list.
Set the Execution Priority and Run Priority.
Click the Destination button to bring up the list,
as in the next step.
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8.

Select one or more Destinations by clicking (or
Control-Click or Shift-Click) on a Destination and
then on the double-arrow button. Then click OK.

Single destinations
Group destinations

To remove a destination
from the list on the
right, click on it and
press the Delete key.

9.
NOTE
If you do not set a schedule for
this command, you can
implement the command using
a display command rule. (See
“Adding a display command
rule” on page 84.)
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Specify the Owner. (Available only if activated
by the administrator.)
10. If you wish to specify a date and time for the
command to be executed, click on the Schedule
Command checkbox.
11. Next, set the schedule’s Start and End Date. Do
this by clicking on the down-arrow by the date.
A monthly calendar will pop up. Select a date
from the current month, or move to a different
month with the left- or right-arrow. Click on the
desired date on the calendar. It will be used for
the schedule date. In this example, 8/7/00 is
chosen for the start date, as in the picture below.

Using commands to control messages

12. Complete the scheduling by setting the Start and
End Time. Do this by clicking on each element of
each time (that is, the hour, minute, or second)
and then using the up- or down-arrows to
increase or decrease the setting. You can also
type the number.

NOTE
If you set a schedule for this
command, the Recurrence
column in the main window will
indicate either “yes” or “no”. If
there is no schedule, it will be
blank. (See the picture in
“Accessing the Command
Manager application” on
page 76.)

13. You can set recurrence timing by clicking on the
Recurrence… button. This gives these options:
• None
• Daily (every x number of days or every
weekday)
• Weekly (every x number of weeks on specific
days)
• With an end date (none, after x number of
occurrences, or by a specified date.)
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After you set the recurrence options, click OK.

14. Click either Add or Apply for the Add Display
Command window.
15. Command execution: If you do not set recurrence
timing, the command will be executed for the
scheduled date and time only. If you do not
specify a schedule for this command, it will be
executed based on a display command rule that
must be set up for this command in Variable Rule
Manager. (See “Adding a display command rule”
on page 84.)
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Creating variable rules
Variable Rule Manager is used to designate display
command rules (pre-defined conditions with resulting
actions) for how to use a variable to trigger a command
to be issued. For more information, please see “How
Smart Alec uses variables” on page 26.
A display command rule identifies variables to use
as tools to trigger display commands, which, in turn,
trigger actions, such as displaying a message, based on
comparing the value of a variable with another value.
A display command rule is in the format of:
If <value1> compares favorably to
<criteria1>,
(and/or <value2> compares favorably to
<criteria2>)
then do <display command>.
Examples:
1. If temperature of machine >= 212°, then
display the “temperature alarm” message.
2. If counter = 1000, then display the
“production goal” message.
3. If sales >= 1000 and net profit >= 1 million,
then display the “congratulations” message.
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Accessing the Variable Rule Manager
From the System Use group on the SA Bar, click once
on Variable Rule Manager. A screen like the one shown
below will appear, listing any existing variable rules.

Adding a display command rule
1.

Add a display
command rule

84

Choose the button to add a new display
command rule.

Creating variable rules
2.

NOTE:

Enter the information to define usage of this
display command rule. The final result of this
window creates a statement expressing a
conditional command, that is, a command that
will only be executed if all the preceding
conditions are met. See the table below for
explanations.
Use care when setting this statement. If this
statement is not set correctly, either nothing
will happen or the wrong action will be taken.
C

A
D

B
E
F
Each row of this
table creates a
phrase in the
conditional
command
statement.

Item

Name

A
B
C

Rule name
Trigger Variable
New

D

Ownership

E
F

Description
Format

G

H

I

J

K

L

Description
Type the name by which the rule is to be called.
Select the variable to be used to start this rule’s test.
Use this button when you need to create a new variable to use as the trigger for the
rule’s evaluation.
Specify who can access and use this rule. (Available only if activated by the
administrator.)
• Public: This rule can be used by anyone. Use this in a single-user system.
• Private: This rule can only be used by the person who created it. Use this only in a
multi-user system.
Type the description of the rule, for clarity. (Optional)
Shows the complete format of the rule you create. Automatically entered by Smart
Alec as you complete the sections of the rule.
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Item
G

Name
Boolean operators

Description
Choose as appropriate from the following list:
• If
• And
• Or
• Then
• Else
The choice depends on what you want the rest of the row to do in relation to the other
phrases.
The first row always starts with “IF”. Items F, G, H, and possibly J must be
completed. The last row you use must always start with “THEN” or “ELSE” and end
(Item I) with the command you want to be done when the entire statement is
executed. A “THEN” statement can be used to activate a command to turn on a
message and the “ELSE” statement can be used to activate a command to delete that
message (when the conditions to turn on the message are not met.)

H

Operand 1

I

Operator

J

Operand 2

K

Resulting display action

L

Variable/literal value
switch

You can have rows in between the first and last rows and these can start with either
“AND” or “OR” to create additional conditions that must be met before the command
will be done.
From a list of date, day, time or existing variables, choose the variable to test by
clicking edit to the left of this column for this phrase.
Choose from the following list for comparing Operand 1 with Operand 2:
• Is equal to ( = )
• Is not equal to ( != )
• Is greater than ( > )
• Is greater than or equal to ( >= )
• Is less than ( < )
• Is less than or equal to ( <= )
Specify the value to compare Operand 1 to. Can be a variable or a literal value. (See
Item K.)
Choose the display command to be executed when all conditions are met.
Make the choice from a list of existing display commands or groups of display
commands by clicking edit to the left of this column for this phrase.
Click as needed to set this as checked or unchecked. (Item G can not be “Then”.)
• Checked: The choices for Operand 2 consist of variables in a drop-down list.
• Unchecked: You can type in your own specific value for Operand 2.

3.
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Click either Add or Apply for the Add Display
Command Rule window.

Grouping notification devices

Grouping notification devices
Notification Device Group Manager is used to designate
logical groups of devices to facilitate sending a message
to multiple notification devices simultaneously.
NOTE:

Notification devices are created using
Notification Device Setup. See “Identifying
notification devices” on page 38.

Accessing Notification Device Group Manager
From the System Use group on the SA Bar, click once
on Notification Device Group Manager.
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Adding a Notification Device Group
1.

Choose the button to add a new notification
device group.

2.

For this example, we will add a notification
device group called “Front offices”, as shown
here. See the table below for descriptions.

Add a notification
device group

A
B

C

D
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Item

Name

A
B
C

Group name
Group Description
Ownership

D

Notification Device

Description
Name of the notification device group as it will be known
Description of the notification device group, for clarity (Optional)
Specify who can access and use this notification device group. (Available only if
activated by the administrator.)
• Public: This group will be available to everyone. Use this in a single-user system.
• Private: This group will be available only to the person who created it. Use this
only in a multi-user system.
Choice of notification devices to be included in the group. The list on the left shows
all available devices. The list on the right shows the devices to be included in the
group.

3.
4.
5.
6.

7.

Specify a name for the group, in this case “Front
offices”.
(Optional) Provide a description.
Designate ownership. (Available only if set on by
the administrator.)
Choose any notification devices from the list on
the left by clicking the device and then the
arrows button or by double-clicking the device.
Choose either Add or Apply.
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Grouping display commands
Display Command Group Manager is used to designate
logical groups of display commands. Then you can create
another command to submit the command group. Doing
this lets you essentially issue a series of commands all at
once.
NOTE:

Display commands are created using Command
Manager. See “Using commands to control
messages” on page 76.

Accessing Display Command Group Manager
From the System Use group on the SA Bar, click once
on Display Command Group Manager.
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Adding a Display Command Group
1.

Choose the button to add a new display
command group.

2.

For this example, we will add a display
command group called “Line counts”, as shown
here. Click on either Add or Apply. See the table
below for explanations.

Add a display
command group

A
B

C

D
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Item

Name

A
B
C

Group name
Group Description
Ownership

D

Display Command

Description
Name of the display command group as it will be known
Description of the display command group, for clarity (Optional)
Specify who can access and use this display command group. (Available only if
activated by the administrator.)
• Public: This group will be available to everyone. Use this in a single-user system.
• Private: This group will be available only to the person who created it. Use this
only in a multi-user system.
Choice of display commands available to be included in the group. Click on any you
wish to include. The list on the left shows all available display commands. The list
on the right shows the display commands to be included in the group.

3.
4.
5.
6.
7.
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Specify a name for the group, in this case “Line
counts”.
(Optional) Provide a description.
Designate ownership. (Available only if set on by
the administrator.)
Choose any display commands from the list by
clicking the check boxes.
Choose either Add or Apply.

System Administration

Advanced functions
The functions in this section are those for which
higher authority is needed (in a multi-user system) or
which are seldom needed.
Higher authority is needed to create multi-user
system-wide security authorization, using System
Administration, User Account Security Setup, and
Application Security Setup.
Seldom used are Notification Device Interface Setup
and Event Log Manager.

System Administration
System Administration is used by the system
administrator for system-wide or high-level settings.

Accessing the System Administration application
From the Advanced group on the SA Bar, click once on
System Administration. A screen like the one shown below
will appear.
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Components of the System Administration window
The picture below is representative of the System
Administration window. See the table below for
explanations of the components.
A

B

C

D

Item
A

B

C

D
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Name
Administration Levels

Description

Allows you to see security settings or to hide them from all screens. The system
installation default is “hidden”, for a single-user system. In this case, all users
except “Alec” are set to level 50 for Update and Detail authorization for all
applications. To change 50 to any other setting, set Administration Levels to
“Shown” and make the changes in User Account Security Setup and/or Application
Security Setup. This, in effect, creates a multi-user system.
Administration Levels must be set to “Shown” for Default Ownership to be available.
Default Ownership
Sets a default for ownership of system resources (i.e., notification devices, variables,
and commands). The actual setting for any resource for any user can be changed at
any time.
• Public: Resources will be available to everyone. Use this in a single-user system.
You may also use this, if desired, in a multi-user system.
• Private: Resources will be available only to the creator. Use this, if desired, only in
a multi-user system.
Socket Handler
Sets the port number for the Socket Handler connection. The default number is 8150.
If you wish, you can type a different port number. See “Importing external data using
sockets” on page 64 for more information.
Variable Category Settings Creates user-defined categories for variables (Optional.) See below.

System Administration

Managing categories for Variables
To create a new category for variables:
1. Check “Use Variable Categories”.
2. Type the desired name in the box for a new
category.
3. Click the Add button.
4. Click OK or make other changes.
To delete a category from the existing list:
1. Check “Use Variable Categories”.
2. Highlight the desired category in the existing
list.
3. Click the Delete button.
4. Click OK or make other changes.
For more information about variables, see
“Identifying variables” on page 42.

New
Existing
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Security authorization
Security concepts
Smart Alec security is used to permit or deny access
to applications, functions, and system resources in order
to separate administrative and setup functions from
general management functions.
Security is set up such that there are levels for
authority from 1 (greatest authority) to 99 (least
authority). That is, the lower the number, the more
authority you have, up to the point of your being
“number 1.”
The security level is set for each user to determine
how much authority the user is granted to access
applications, functions, and system resources. The
security level is also set for each application/function
and system resource to determine the minimum
authority needed for a user to access them. If a user’s
authorization level is greater than or equal to the
minimum needed for that application/function or
system resource, then access is granted to that user.
User security
authority

Example 1
User can access the
system resource

Security authority
needed
1

Authority
granted = 5

Authority needed
(minimum) = 75
99
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User security
authority

Example 2
User can access the
system resource

Security authority
needed
1

Authority
granted = 50

Authority needed
(minimum) = 50

99

User security
authority

Example 3
User can not access
the system resource

Security authority
needed
1
Authority needed
(minimum) = 5

Authority
granted = 75
99

Where security is used
The security system is used for:
• creating and using system resources (i.e.,
notification devices, variables, commands)
• using applications (programs to run, some of
which can create, authorize, or change system
resources)
• using application functions (view details, make
updates)
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Security system controls
Applications
•

•

If you have enough “details” authorization to
use an application, that application will appear
in the SA Bar for you. You will be able to use that
application and view details of any data in it.
If you have enough “update” authorization for
an application, that application will also appear
in the SA Bar for you. You will be able to view
details and, in addition, you will be able to make
changes using that application.

Resources
•

•

Some applications can create and manage system
resources. If you have sufficient “details”
authorization for a system resource, you will be
able to view details of any system resource data.
For system resource applications, if you have
sufficient “update” authorization, you will be
able to view details and, in addition, you will be
able to make changes to system resources.

Data
•

Some applications can create data that can be
designated as public or private. Each user who
creates data in one of these applications
determines whether that data is to be available to
other users (public) or to only himself (private)
when anyone is using that application. Then
when that application is to present data to any
user, the application checks to see if the data
requested is for public use or only for private
use. If the user is the creator of the data or if the
data is for public use, the data is displayed.
Otherwise, it is not.

•

Similar to data, processing (display) commands
can be designated as public or private.

Processing
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Given all the above points, it is possible to have
authorization to access an application for a specific
system resource and to create one of those system
resources, but not have enough authorization to use that
system resource. For example, you could be authorized
to use Notification Device Setup to initialize a new
notification device, but not be authorized in Notification
Device Group Manager to group that new notification
device with others.

Classes of users
While security is set up such that there are levels of
authority from 1 (greatest authority) to 99 (least
authority), it is easiest to work with just a few levels. A
default level of 50 has been established for a general level
user, while a default level of 5 has been established for an
administrative level user. Any other levels are acceptable
for customized users, but 25 and 75 might be good
choices because they are easy to use.
See “Creating user environments” on page 102 for
detailed instructions for setting up individual users.

General user: lower authorization, set by system administrator
The default authorizations for a general user are as
follows. These authorizations give normal access for
applications and system resources for routine
management of the system. This is how all users are
initially set up in Smart Alec for all applications and
system resources. Notice that all authorization level
values are the same and therefore, all users have the
same system access.
Type of authorization
Application
Application
Processing
System resource
System resource

Scope of authorization
Applications–full access
Applications–details access
Commands
Notification Devices
Variables

Authorization
level
50
50
50
50
50
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Administrative user: greater authorization, set by system administrator
The default authorizations for an administrative user
(such as “Alec”) are as follows. These authorizations give
high-level administrative access to set up applications
and system resources.
Type of authorization
Application
Application
Processing
System resource
System resource

Scope of authorization
Applications–full access
Applications–details access
Commands
Notification Devices
Variables

Authorization
level
5
5
5
5
5

Custom user: uniquely set up as needed
Authorizations for a custom user vary according to
an individual’s need to access applications and system
resources. Great care must be taken when setting up
custom user authorizations and matching them with the
settings for applications and system resources.
Otherwise, some users may be inadvertently denied
access.
The following is an example of one possible way to
create another class of user.
Type of authorization
Application
Application
Processing
System resource
System resource

Scope of authorization
Applications–full access
Applications–details access
Commands
Notification Devices
Variables

Authorization
level
75
25
50
50
75

This example gives limited access to variables and to
update (“full access”) applications, gives broad access to
view details in applications, and gives normal access to
commands and notification devices.
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Setting minimum security levels for applications and system resources
Security levels authorized for users work together
with security levels for applications and system
resources. Authorization levels are set for each user for
applications in general, as shown above. In addition,
minimum authorization levels are set for each specific
application. If a user’s authorization range is greater than
or equal to the minimum needed for an application, then
access is granted to that user.
Normally, default authorization levels for both users
and applications are set to 50. However, in the Smart Alec
system with the custom user illustrated above,
application security could be set up with these settings
for the applications shown here:

Specific application
Application Security Setup
User Account Security Setup
Notification Device Setup
Notification Device Group Manager
Variable Rule Manager

Minimum
authorization
level needed
5
5
50
75
50

In this example, a high level of authority is needed to
gain access to Application Security Setup and User Account
Security Setup. The user in this example does not have
that level of authority. So these applications would not
appear in the SA Bar for him. But he does have sufficient
authority for full (update) access to Notification Device
Group Manager and for details (read) access to both
Notification Device Setup and Variable Rule Manager.
Therefore, he would be able to make updates in
Notification Device Group Manager, and he would be able
to see details but not make updates in Notification Device
Setup and Variable Rule Manager.
See “Authorizing applications and application
functions” on page 108 for detailed instructions.
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Creating user environments
The Smart Alec system is designed so that it can be
used by many different people in a company in different
ways. The purpose of User Account Security Setup is to
establish users and to assign levels of authorization to
any user for applications, variables, commands, and
notification devices. In other words, you decide if users
can access a given resource (application, device, etc.) and
what functions they can do with it.
In a single-user environment, you only need to
establish who the users are. All users have the same
access to all system resources, so there is minimal setup
for users.
However, in a multi-user environment, some people
may need to have different access to various
applications. For example, an administrator will need to
have full access to all applications, while regular users
might have access to only a few applications that they
use. The Smart Alec security system allows users who
have sufficient access authorization for applications to
create, update and delete users.

Accessing the User Account Security Setup application
From the Advanced group on the SA Bar, click once on
User Account Security Setup. A screen like the one shown
below will appear, listing any existing users.
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Setting up a user
In the user security screen, each row shows all the
security authorizations for a given user.
• Select a user by clicking to the left of the row
once.
• Add a new user by clicking the New User button.
• View, duplicate, update, or delete the chosen
user by using the buttons on the toolbar or from
the drop-down File menu.
• You can also access the screen to update a user
by double-clicking to the left of the row.
Update this user

View details
for this user

Delete
this user

Duplicate
this user
New user

Select a user by clicking here.

The Smart Alec system comes installed with a default
user of “Alec” so you can access the system immediately
as user “Alec”. “Alec” has no password assigned. You
can keep the user as “Alec,” or you can change the name
or authorization of this user as desired. However, be sure
to create a new user with full access before changing or
deleting “Alec”.

Default Authorizations
The default authorization for applications and
system resources for user “Alec” is 5. These
authorizations give high-level administrative access.
The default authorization for applications and
system resources for any other user is 50. These
authorizations give normal access. In a single-user
environment, you should not change this setting.
For a conceptual understanding, see “Security
authorization” on page 96.
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Adding a user
To add a new user, do the following:
1. From the File menu, choose New, or click on this
button:
2.

Fill in the values as appropriate for the new user.

A
B

C

Item
A
B

C

Name

Description

User name
Password

Name by which this user is known. This field is not case-sensitive.
For security, a set of characters to be entered by the user when logging into the
system. May be left blank, if desired, except that, to use the Socket Handler Setup
(see page 64) there must be a password. This field is case-sensitive.
Application Authorizations System processors validate requests against the level authorized for the user. If the
and levels
user’s level of authorization is equal to or higher than that required, the request is
processed. These are set to a default of 50. In a single-user environment, these
should not be changed from 50. In a multi-user environment, these are normally set
to either 5 (administrator) or 50 (general), but they can be set to any desired level.

NOTE:
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For better understanding, see “System
security” on page 6 and “Security
authorization” on page 96.
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Authorizing user passwords
User-authorized password
You, as a user, can add or change your own
password at the Login screen. If you change your own
password, the system administrator will not be notified
and will not have access to what your password is. If you
forget your password, the administrator can only change
it for you to a new password. You can then change it back
to what you want it to be.
1. When logging into Smart Alec, click Change
Password. (You do not need to supply a password
on the main Login screen.)

2.

If there was an existing password, you must type
that on this next screen. Then type the new
password, and retype it again exactly the same
way. You can use a new password, as shown
below, or you can use a blank password for New
Password. Using a blank new password, in effect,
deletes any old password.

3.
4.

Click Change.
You will next be logged into Smart Alec.
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Administrator-authorized password
The administrator can add or change the password
for a user.
1. From the User Account Security Setup and Security
application, highlight the entire row for the user
by clicking in the column to the left of that user.

Update button

Click in this column
to select a user.
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2.

From the File menu, choose Update, or click on
this:

3.

Click New Password.

Creating user environments
4.

Type in the new password. Regardless of what
the old password was, the default password
supplied is “smartalec”. You can use “smartalec”
(as shown below,) you can use a different
password, or you can use a blank password.
Using a blank password here, in effect, deletes
any old password. Then click OK.

5.

Click Update.
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Authorizing applications and application functions
The purpose of Application Security Setup is to
designate what level of authorization is needed by users
to access specific applications and the functions in each.
In a single-user environment, all users have the same
access authority for all application categories and all
functions for each application. This access authority is
automatically preset to 50 for applications and
application functions.
In a multi-user environment, the system
administrator can set unique levels for the access
authority required for each application. The level can be
set for both “update” (make changes to data) and
“details” (only view details of data) functions. If the level
of authorization assigned to a user is equal to or greater
than the level of authorization required for a given
application, the user can access that function for that
application. (Levels of authorization go from a low of 99
to a high of 1. A lower number gives higher authority.)

Understanding application functions
Update
A user with sufficient authorization for update
application access can use all functions in any Smart Alec
application for which he has authority. This is especially
common in a single-user environment, where all
authorization values are the same for all users, so all
users can access all applications and all application
functions.

Details
A user with sufficient authorization for details
application access, but not enough to update
applications, can only access the details function in any
Smart Alec applications to which he has authority. This is
especially common in a multi-user system configuration,
where some users only need to view data in the Smart
Alec system.
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Accessing the Application Security Setup application
From the Advanced group on the SA Bar, click once on
Application Security Setup. A screen like the one shown
below will appear, listing existing settings.

Authorizing application security
The initial value for update and detail authorization
levels is automatically preset to 50 for all users (except
for the system-installed user “Alec”) and for all
applications (except for the administrator applications:
System Administration, User Account Security Setup, and
Application Security Setup.)
In a single-user environment, the authorization level
should remain at 50 for all new users.
To create a multi-user environment, the Smart Alec
administrator can change either the update or detail
values for any application (in Application Security Setup)
or for a user’s security (in User Account Security Setup.)
Doing this can block access to functions for these users.
The graphic below indicates the meaning of the
Application Security Setup window.
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Details button – allows you to view, but
not to change, values in this application.

Update Value indicates
the level of authorization
a user needs in order to
be able to change any
values in that application.

Update button –
allows you to
view and change
values.

Detail Value indicates the
level of authorization a
user needs in order to be
able to view any values in
that application. Without
sufficient authority here,
the user will not even be
able to access the
application.

Click in this
column to
select an
application.

Application
AppSecurity.exe
CommandManager.exe
DCGroup.exe
DDEInput.exe
DeviceInterface.exe
EventLogManager.exe
Message Manager.exe
NDGroup.exe
NotificationDeviceSetup.exe
OPCDataSourceSetup.exe
SAShutdown.exe
Security.exe
SystemAdministration.exe
VariableRuleManager.exe
VariableSetup.exe
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Application name
Application Security Setup
Command Manager
Display Command Group Manager
DDE Data Source Setup
Notification Device Interface Setup
Event Log Manager
Message Manager
Notification Device Group Manager
Notification Device Setup
OPC Data Source Setup
Smart Alec Shutdown
User Account Security Setup
System Administration
Variable Rule Manager
Variable Setup

Authorizing applications and application functions
Authorization for each application can be changed
individually as follows:
1. Highlight the application to change by clicking
in the column to the left of that application. Then
click Update.

Update button

Click in this column to
select an application.

NOTE
Remember, the lower numbers
mean that more authority is
needed to access the application.

2.

Assign the values needed for a user to have
authority to update and to view details. Then
click either Update or Apply.

Update Value indicates the level of
authorization a user needs in order
to be able to change any values in
that application.
Detail Value indicates the level of
authorization a user needs in order
to be able to view any values in that
application. Without sufficient
authority here, the user will not
even be able to access (see) the
application.

Use this drop-down
arrow to select another
application to view and
change.
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3.

The following are suggested values for both
update and details levels for a single-user
environment and for a multi-user environment
with an administrator and one or more general
users.
Values

System application name
AppSecurity.exe
CommandManager.exe
DCGroup.exe
DDEInput.exe
DeviceInterface.exe
EventLogManager.exe
Message Manager.exe
NDGroup.exe
NotificationDeviceSetup.exe
OPCDataSourceSetup.exe
SAShutdown.exe
Security.exe
SystemAdministration.exe
VariableRuleManager.exe
VariableSetup.exe
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Common application name
Application Security Setup
Command Manager
Display Command Group Manager
DDE Data Source Setup
Notification Device Interface Setup
Event Log Manager
Message Manager
Notification Device Group Manager
Notification Device Setup
OPC Data Source Setup
Smart Alec Shutdown
User Account Security Setup
System Administration
Variable Rule Manager
Variable Setup

Single-user
Multi-user
environment environment
5
50
50
50
50
50
50
50
50
50
50
5
5
50
50

5
50
50
5
5
5
50
50
5
5
5
5
5
50
5
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Viewing application authorization levels
1.

Highlight the application by clicking in the
column to the left of that application. Then click
the Details button.

Details button

Click here to
select the
application.

NOTE
Remember, the lower numbers
mean that more authority is
needed to access the
application.

2.

You can now see the values needed for a user to
have authority to update and view details for
this application. Then click Close. No changes
will be saved.

Update Value indicates the level of
authorization a user needs in order
to be able to change any values in
that application.
Detail Value indicates the level of
authorization a user needs in order
to be able to view any values in that
application. Without sufficient
authority here, the user will not even
be able to access the application.

Use this drop-down
arrow to select another
application to view.
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Identifying notification device interfaces
Notification Device Interface Setup is used to designate
the type of hardware to be used for sending messages to
notification devices. A notification device interface is
normally set up the first time that a notification device
needing it is initialized, but it also can be set up before a
device is initialized, for instance, before the hardware is
actually installed.

Types of notification device interfaces
There are several types of notification device
interfaces. For descriptions, please see “Appendix 2:
Types of Notification Device Interfaces” on page 124.

Accessing the Notification Device Interface Setup application
From the Advanced group on the SA Bar, click once on
Notification Device Interface Setup. A screen like the one
shown below will appear, listing any existing notification
device interfaces.
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Adding a notification device interface
1.

Choose the correct button for the type of
notification device interface you wish to add.
Local Pager
Interface

Terminal Server
Interface

Wide-area
Pager Interface
Email
Interface

Serial
Interface

2.

NOTE:

For this example, we will add a wide-area pager
interface, as shown here. See the table below for
explanations.
A modem must be installed on this computer
for a wide-area pager.

A
B
C
D
E
F
G
H

I
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Item

Name

A
B
C

Interface name
Description
Modem name

D

Number to dial

E

Baud rate

F
G

Com port
Packet size

H

Communications
properties
Advanced dialing
properties…

I

Description
Name of the interface as it will be known.
Description of the interface, for clarity. (Optional)
Name of the modem used for the pager. At least one modem must already be
installed. If only one modem is attached to this computer, its name is automatically
chosen. Otherwise, choose the correct modem from the list.
Type the complete phone number to be dialed to access the paging service. This
includes any external access code, international code, area code, number, and any
other codes needed, for example, *70 to disable call waiting. You can use any
character that is valid for your modem. A comma denotes a 2-second pause. Other
characters such as spaces, parentheses, dashes and periods are acceptable for visual
clarity, but are not required.
The speed of the modem used when sending to the pager. The default setting is 9600
baud., which is the baud rate that must be used with an ALPHA sign.
The COM port to which the modem is attached.
The maximum number of bytes the pager can process at a time. The default is 175.
(Contact your wide-area paging service if needed.)
Choose one of the available sets of properties for transmissions. The default setting
of 8 bits, no parity, and one stop bit is recommended.
Choose this button to set up the modem initialization string and the number of
retries. This function is only for the wide-area pager interface.

3.

For the dialing properties for this example,
choose the correct settings for the wide-area
pager interface. See the table below for
explanations.

A
B

Item
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Name

A

Modem Initiation String

B

Number of retries

Description
Initialization string to use for this modem. See the documentation for your modem for
more information.
Number of times to attempt connection.

Identifying notification device interfaces

Settings for additional notification device interfaces
In addition to the wide-area pager illustrated above,
here are settings for serial, email, local pager, and
terminal server interfaces. Note that there is no modem
interface.

Serial interface
Item
A
B
C

Name
Interface name
Description
Interface settings

Description
Name of the interface as it will be known.
Description of the interface, for clarity. (Optional)
For an ALPHA sign, the default settings of 9600 baud, 8 bits, no parity, and one stop
bit are recommended. Specify Com Port as appropriate for your computer.

Email interface
Item

Name

A
B
C

Interface name
Interface Description
Email profile

D

Email password

Description
Name of the interface as it will be known
Description of the interface, for clarity (Optional)
Email identity to use. This is the default user of the computer, not necessarily the
Smart Alec user name. See your system administrator if unsure.
Password that is valid in the network for the email profile. When an email interface is
set up, there is an additional prompt to confirm the password. This password is only
used for sending email through the network.

Local pager interface
Item

Name

A
B
C

Interface Name
Interface Description
Interface settings

D

Packet Size

Description
Name of the interface as it will be known.
Description of the interface, for clarity. (Optional)
Choose appropriate settings for this interface. To find these settings (except for
Packet Size) click Start > Settings > Control Panel > System. Next, click the “Device
Manager” tab and then Ports. Finally, double-click the COM port you need and then
the “Port Settings” tab. The default settings of 9600 baud, 8 data bits, no parity, and
one stop bit are recommended.
The maximum number of bytes the pager can process at a time. The default is 175.
For details, refer to the documentation for the pager or contact your network system
administrator.
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Terminal server interface
Item
A
B
C
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Name
Interface Name
Interface Description
IP Address

Description
Name of the interface as it will be known.
Description of the interface, for clarity. (Optional)
The four-node Internet Protocol address of the terminal server, for example:
192.40.13.10. Consult your network system administrator if needed.
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Managing the log of Smart Alec system events
For system support purposes, Smart Alec monitors
and creates a log of all events that occur within the
system. This log is available to view by using the Event
Log Manager.

Accessing the Event Log Manager
From the Advanced group on the SA Bar, click once on
Event Log Manager. A screen like the one shown below
will appear. See the table below for descriptions.
B
A

Item
A
B
C

Name
Write to file
Delete
Archive

D
C

F
E

H
G

Description
Create a tab-delimited print (.prn) file with user-selected fields from the database.
Delete selected event(s).
Save the entire database as a text (.txt) file.
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Item
D
E
F
G
H

Name
Filter
Sort Ascending
Sort Descending
Search
Value to search for

Description
Select only events that fit specific criteria (data/time and/or database field).
Sort A to Z or 0 to 9.
Sort Z to A or 9 to 0.
After selecting a column, use this to search for a specific value.
Enter the value to find.

Options for viewing the event log database in the Event Log Manager
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•

Write to a file: Create a tab-delimited print (.prn)
file with user-selected fields from the database.

•

Filter: Select only events that fit specific criteria
(date/time and/or one or more database fields)

Managing the log of Smart Alec system events
•

Refresh (from Edit menu): Update the list of
events

•

Invert selection (from Edit menu): Select only
those records not already selected.

•

Sort: Sort high-to-low or low-to high.

Options for managing the event log database
•

•

•

•

Select all: From the Edit menu, choose Select All to
highlight all records. This allows you to then
delete all records at one time.
Select some records: To select specific records, you
can click on one and then shift-click or controlclick on more. This allows you to delete
individual records.
Deleting records: With records selected as above,
press the Delete key. You will be prompted to
confirm the deletion.
Control database size: From the Tools menu, choose
Preferences to set preferences to limit the number
of events listed in the database to a specific
threshold number, to overwrite the oldest
records (never, as needed, or after x number of
days), and to state the wording of the warning
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message when the number of events in the
database has reached the limit.
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Appendices
Appendix 1: Smart Alec computer requirements
Make sure your computer system fits these
minimum requirements:
•
•
•

•
•
•
•
•

Personal computer, IBM or compatible
Pentium 200 MHz processor, minimum
Microsoft NT Workstation 4.0 (strongly
recommended), or
Microsoft Windows 98, or
Microsoft Windows 95
64 MB RAM
25 MB hard disk storage space
SVGA 800 x 600 color monitor
Mouse
CD-ROM drive
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Appendix 2: Types of Notification Device Interfaces
The Smart Alec system includes the following
notification device interfaces. For specific networking
information, refer to Network Configurations, PN
9708-8046.
NOTE:

You may have purchased notification devices
from other third party sources. Hardware
support for these devices is not provided by
Adaptive Micro Systems. You will need to
consult the third party source for any needed
technical support.

Serial interface
A serial notification device interface uses cables to
directly connect ALPHA SA signs to a computer, and
messages are sent over this cabling.
A serial interface works best when all the notification
devices are in one building.
PC – sign – sign – sign – etc.
ALPHA sign

ALPHA sign

ALPHA sign
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Email interface
An email notification device interface sends
messages over a network using an email service.

Local pager interface
A local pager notification device interface uses a
transmitter attached to a computer and a wireless
receiver attached to a notification device. Messages are
sent from the computer via the transmitter to any
TAP-compliant wireless pager and then to the receiver at
the notification device.
The advantage of this connection method is that
wiring does not have to be strung between notification
devices and/or the computer.
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Wide area pager interface
A wide area pager notification device interface uses a
modem attached to your computer and a wireless
receiver attached to a remote notification device, either a
display or a pager. Basically, when a message is sent, it is
transmitted to the remote notification device when the
computer modem calls the device’s modem. Specifically,
a message is sent from your computer to the attached
modem. The modem then dials a paging service, such as
SkyTel, and this paging service actually transmits the
message to the wireless receiver.
A modem connection is often used for devices that
are not in the same building and possibly not in the same
city. It works best when message data does not change
rapidly.

tr(Þ)Ta9383.623 370.979383.623 7 370.5 39383.623 68.459 96.95.66 367.03296.2.037 365.693 6 638 TD(Mode

Modem
PC with Smart Alec software
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Terminal server interface
A terminal server notification device interface uses a
Local Area Network cabling system to transmit messages
to a device with an IP address on the LAN. (For specific
information about Alpha Ethernet Adapters, refer to
Networking ALPHA signs with ALPHA Ethernet
Adapters, PN 9708-8093.)
PC – LAN network – terminal server box – sign – sign – sign – etc.
ALPHA sign

ALPHA sign

Alpha
Ethernet
Adapter

ALPHA sign

PC with
Smart Alec software

PC with
Smart Alec software

TCP/IP

Terminal
Server

LAN
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Appendix 3: Understanding modes on signs
Modes are special effects used to change the way a
message appears on a sign.
Table 2: How modes function
Mode

Function

Automode

This is the default mode, which actually consists of using all other modes available
to each sign. If no other mode is selected, the message will appear in Automode.
All characters flash off and on from the point of flash mode until the point where
another mode is selected, if any.
Holds the message or specified text in a fixed place for several seconds.
Alternating rows of dots enter from each direction of a sign and interlock to form the
message in the center of the sign.
Rolls the characters in the message in their entirety onto the sign in the desired
direction. You can choose to roll up, down, left, right, in, or out.
Rotates a message from right to left across the sign without stopping. For certain
signs, text can be condensed or standard.
Moves the message one line at a time from bottom to top of the sign. The previous
line is pushed off the sign.
The message moves onto the sign from one direction to the other, one character at a
time.
The dots of each character in the message fall randomly onto the sign as if it's
snowing.
The message sparkles onto the sign by randomly filling the letters of the message (at
the start of the message display only.)
The message is sprayed onto and across the sign, left to right, column-by-column
and character-by-character.
Random starbursts explode over and around letters of the message on the sign.
Alternating characters of the message slide onto the sign from different directions,
that is, the first character slides up, the next down, etc.
The message appears in its entirety in a twinkling effect with lights flickering off and
on for the duration of the message display.
The message is wiped onto the sign in the direction specified, filling in each of the
characters row-by-row or column-by-column. It looks as if it's washing over the old
message. You can choose to roll up, down, left, right, in, or out.

Flash
Hold
Interlock
Roll
Rotate
Scroll Up
Slide
Snow
Sparkle
Spray
Starburst
Switch
Twinkle
Wipe

128

Appendix 3: Understanding modes on signs

Table 3: Modes available on signs
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Spray

●
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Condensed

●

●

Standard
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●

Roll

●

FM

Hold

FM

Alpha 220C

Flash

Series 200

ALPHA
sign

Type

Slide

●
●

Scroll

Twinkle

Switch

●

●

Switch half the display

Starburst

●
●

Sparkle

Snow

Rotate
Interlock

Automode

Cycle color

Modes

Sign
(FM = Full Matrix,
CM = Character Matrix,
LM = Line Matrix)

Big Dot
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●
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Appendix 4: Understanding line positions (Top, Middle, Bottom, Fill)
Line positions on signs
The “line position” refers to where a message can be
displayed on a sign — the top, middle, bottom, or fill
positions. Line position are available with most modes,
e.g., Hold, Snow, Sparkle, etc. While the way these work
varies slightly on different types of signs, the basic
concept is shown in the pictures here.
Line
position

What appears in the
Message Manager:

What is displayed on a 2-line sign:

Top

Middle

Bottom

Fill

Types of signs
Signs are categorized by number of lines of text.
1. Single-line (BETAbrite 215R & 215C, 220, 300
series, 400 series, Big Dot)
These signs are of varying lengths but are always
7 dots high.
2. Double-line (4000 series)
These signs are of varying lengths but are always
16 dots high.
3. Triple-line (7000 series) and Multiple-line full
matrix (Alphavision)
These signs are of varying heights and widths.
4. Multiple-line character matrix (AlphaVision,
Director)
These signs are of varying heights and widths,
but have character blocks with spaces between.
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Single-line (BETAbrite 215R & 215C, 220, 300 series, 400 series, Big Dot)
On a single-line sign, all characters line up at the
bottom of the sign and work their way up for as many
dots as the font supports.
Example:

Exception conditions:
• If the sign receives a font that is larger than the
sign can display, it will “size it down”.
• 7-high normal characters are substituted for
any 15-high normal characters.
• 7-high fancy characters are substituted for
any 15-high fancy characters received, etc.
• If a graphic (picture) is received that is taller than
the display can show, the top seven rows are
displayed.
• If a graphic is received that is wider than the
display can show, it will show the left-most
columns of the picture.
• If a graphic is received that is smaller than seven
dots tall, it will be displayed from the bottom of
the sign working up, similar to the 5-dot
character set shown above.
• If a character set is not established in the
message, 7-high normal characters are used.
• If top, bottom, or fill positions are received,
middle is used.

Double-line (4000 series)
Top position
On a double-line sign, the top position is defined as
the top 7 dots of the sign, and operates in the same
manner as a one-line sign. See exception conditions for a
single-line 7-row sign.
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Bottom position
The bottom position is defined as the bottom 7 dots
of the sign, and it also is treated as a one-line sign. See
exception conditions for a for a single-line 7-row sign.

Middle position
The middle position is treated as though it was one
line of 16 dots. Each line of text presented on that line is
prescanned to determine the largest piece of text (or
graphic object) to be displayed. The line of text is then
vertically centered based on that largest object. For
example, if you have a line of text which has mostly
5-high characters, but has one 10-high character, the line
is viewed as a 10-row high line, and since this is a 16-row
sign, that leaves 6 extra rows… 3 blank rows on the top
and 3 blank rows on the bottom. All text and objects are
then lined up to this new virtual bottom (the 13th line)
and treated the same as in a single-line sign.
Exception conditions:
• If the sign receives a font that is larger than the
sign can display, it will “size it down”.
On this sign, in the middle position, the only
characters that are too large would be characters
using the “double-high” control code. This
control code is ignored.
• If a graphic is received that is taller than the
display can show, the top sixteen rows are
displayed.
• If a graphic is received that is wider than the
display can show, it will show the left-most
columns of the picture.
• If a character set is not established in the
message, 16-high normal characters are used.

Fill position
On a 4000 series sign, the fill position indicates that
you wish to use no more than 7-high characters, and that
you want to fit as much text on the screen as you can.
When in this mode, the sign views itself as having two
lines of 7-high characters, and no means of doing a
character set larger than 7-high. If a graphic is selected, at
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most seven rows of that graphic will be displayed. If the
last piece of text to be displayed (towards the end of the
message) is only one line worth of text, the sign will
place 4 blank rows of dots at the top and the bottom of
the text in order to center the last line of text vertically.
If the sign is operating on the top row, the bottom of
that row is assumed to be the 7th row of dots. All text is
started from there and worked up. (5-row characters will
use rows 3 – 7, while 7-row characters will use rows 1 –
7.)
If the sign is operating on the bottom row, it works its
way up from row 16. (5-row characters will use rows 12 –
16, while 7-row characters will use rows 10 – 16.)
Exception conditions:
• If the sign receives top, bottom, or fill modes and
also a font that is larger than 7-high, it will “size
it down”:
• 7-high normal characters are substituted for
any 15-high normal characters.
• 7-high fancy characters are substituted for
any 15-high fancy characters received, etc.
• If a graphic is received that is larger taller than 7
rows high (15-high for middle mode), the top 7
rows (top 15 for middle mode) are displayed.
• If a graphic is received that is longer than the
display can show, it will show the left-most
columns of the picture.
• If a character set is not established in the
message, 7-high normal characters are used.

Triple-line (7000 series) and Alphavision Full Matrix
Top/Bottom
These two positions work in tandem with each other.
There is an imaginary line between the top half and the
bottom half to the display. We will call this line the
centerline. In the example below, the “Centerline” is
between the “HELLO”, and the “lots of text about
basically”. The centerline divides what is used on the
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sign for top position commands from what is used for
bottom.
Centerline

Establishing the position of the centerline
The centerline position is typically established by the
first top command received, and the rest of the space is
used for the bottom. If the bottom command comes first,
the centerline is placed at its highest possible position,
row 8, allowing for one line of 7-dot characters on the
top. If the top command comes first, and not a bottom,
the centerline’s position is determined by the amount of
text following the position command.
Examples:
• If one 7-dot high line of text is received
(following a top command), the centerline will
be fixed at row 8.
• If one line of 10-dot characters is received
(following a top command), the centerline will
be placed at position 11.
• If two lines of 5-dot high characters are received
(following a top command), the centerline is
placed at row 12 (5 for each line of text, plus the 2
blank rows between the lines.)
Two exceptions to the above rules are as follows:
1. The centerline is never placed higher than 8 rows
from the top of the sign.
2. The centerline is never placed lower than 8 rows
from the bottom of the sign.
Note: This ensures that there is always room for
one line of 7-dot high characters on the top or
bottom (including one blank row.)
Once its position is established, the centerline
remains fixed at that position until a fill or middle
position command is received. All subsequent top or
bottom position commands use the amount of space set
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by the position of the centerline. You cannot change the
position of the centerline with a second top/bottom
command.
Example:
Message = [Top;Hold][Green][SS5][Bottom;Hold]lots
of text about basically nothing
Centerline

Middle position
The middle position is treated as though it were one
line as many dots high as the sign is tall. Each line of text
presented on that line is prescanned to determine the
largest piece of text (or graphic object) to be displayed.
The line of text is then vertically centered based on that
largest object. For example, if you have a line of text
which has mostly 5-high characters, but has one 10-high
character, the line is viewed as a 10-row high line.
Assuming this is a 24-row sign, that would leave 14 extra
rows…7 blanks on the top and 7 blank rows on the
bottom. All text and objects are then lined up to this new
virtual bottom (the 21st line) and treated the same as in a
single line sign.
Exception conditions:
• If a graphic (picture) is received that is larger
than what the display can show, the top-most
rows are displayed.
• If a graphic (picture) is received that is longer
than the display can show, it will show the left
most columns of the picture.
• If a character set is not established in the
message, 7-high normal characters are used.

Fill position
On a 7000 series or Alphavision sign, the fill position
indicates that you wish to fit as much text on the screen
as you can. On these signs as opposed to the 4000 series,
you can select character sets larger than 7-high in the fill
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mode. The sign will start from the top of the screen
working down. If you select a 15-row character set, the
sign will fit as many 15-row lines of text on the screen as
possible. As soon as the sign detects that the next line
will not fit, it will stop creating the current page and
display it. The next page will begin with the line that
would not have fit. If the text does not use up the entire
display, the sign will center the text vertically, splitting
the blank space between the top and the bottom.
Exception conditions:
• If a graphic is received that is taller than seven
rows high, the top seven rows are displayed.
• If a graphic is received that is wider than the
display can show, it will show the left-most
columns of the picture.
• If a graphic is received that is smaller than seven
dots tall, it will be displayed from the bottom of
the sign working up…similar to the 5 dot
character set explained above.
• If a character set is not established in the
message, 7-high normal characters are used.

Alphavision Character Matrix
This sign works exactly like the Triple-line (7000
series) and Alphavision Full Matrix signs, with the
following exceptions.
Exception conditions:
• If a mode other than a “Wipe” mode is received,
it is replaced with “Hold”.
• An Alphavision sign ignores any of the
following:
• graphics
• any character set command except 5- and
7-high normal
• wide
• double-wide
• double-high
• true descenders
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•

• proportional spacing
• animations
If a character set is not established in the
message, 7-high normal characters are used.
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Graphics can be included in a message, as well as
text and variables.
1. Create the necessary graphics, if not already
created. Store them all in the same folder.
• The graphics must be in bitmap (.bmp)
format.
• The graphics must be 256 colors or less.
“True color” is not valid.
• Set the number of pixels (x by y) equal to the
sign size or less.
• Neither black nor white in a graphic show
up on the sign.
• Other colors in the graphic are approximated
by the sign as closely as possible using the
sign’s colors.
2. In Microsoft Access, open SmartAlec.mdb.
3. In the database, open the TB_Global_Init table.
4. For “PathToGraphics”, specify the full path
where the graphics files are saved, ending the
path name with a forward slash (\). Save and
close this table.
5. Still in Microsoft Access and SmartAlec.mdb,
open the TB_graphic table.
6. Specify the graphic files to be used.
• Specify name and description as desired.
• For the Filename, specify the complete name
of the graphic, including the extension but
not the full pathname.
7. Save and close the TB_graphic table and
SmartAlec.mdb.
8. Open Smart Alec. If Smart Alec was open before
setting the PathToGraphics, restart Smart Alec so
the new path in Step 4 will be registered
correctly.
9. Open the Message Editor and choose a new or
existing message.
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•
•

Enter any desired text.
Specify the graphic to display, using this
format: {11,1}
• The “11” indicates that it’s a graphic to be
included and the “1” is the graphic ID
number as seen in the TB_graphic table.
These ID numbers are automatically
generated and remain static for the life of the
record in this table.
10. Save the message.
11. (Optional) Check the syntax of the message:
Tools > Message Syntax Check.
If a message with a graphic included is running and
then the graphic is changed, the graphic in the current
message will not change. To use the changed graphic,
send a command to delete the original message. Then
either 1) create a new message including the changed
graphic and send a new display command for the new
message; or 2) select the original command with the
original message and choose File > Schedule Activities,
reset the schedule, and send this command for the
original message.
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API Process Guide
Purpose
The purpose of this appendix is to serve as a guide
for a developer writing software to interface with Smart
Alec through the Socket Input Handler.

Definitions
•

•

ASCII: American Standard Code for Information
Interchange – A set of values corresponding to
numbers, letters, symbols and codes for
exchanging information. Used in computing to
send data across various lines of transmission.
Null terminated string: A series of ASCII
characters ending with a byte valued at 0. This is
similar to the standard implementation of a C++
character string class.

Theory of Operation
The Socket Input Handler acts as a direct interface
into the system. It handles a Data Source Variable change
of state (COS) process.
You connect to the socket handler using a standard
socket implementation for any computer platform and
the Port number found in the main Smart Alec database.
If the address and port are correct and the socket handler
is running on the host computer, the handler accepts the
connection. The system supports unlimited users (from
different or the same IP Address), as the host computer’s
resources permit.
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Login Sequence
1.

2.

3.
4.

5.

6.

Initiate a standard socket connection with the
host computer using the IP Address of the host
computer and the port number found in the
Smart Alec database.
The Smart Alec Socket Input Handler accepts the
connection and logs the IP address of the client
system.
The client sends a ‘Login Packet’ described later
in this document.
The Socket Input Handler verifies the login name
and password with the database entries to
determine if the client is a valid user.
If the user login is not valid, the Socket Input
Handler sends an ‘Error Packet’ containing a
message to that effect back to the client system. It
then immediately terminates the connection.
If the user login is valid, a ‘Success Packet’ is
returned to the client and operation continues as
normal.

Standard Operation
After a successful connection has been established, a
valid user login has occurred and a ‘Success Packet’ has
been returned, the Socket Input Handler sits in an idle
state waiting for new packets to come in.
At that point, new packets can enter the system at
any time. A packet is introduced into the system by
sending data serially across the socket connection. The
elements of the packet are explained further below, but
the basic ordering is as follows:
• Class
• Subclass
• Message ID
• Priority
• Set of arguments
After the packet has entered the system, the Socket
Input Handler parses the packet header for information
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on how to process the data. The handler knows from the
class and subclass how many arguments to look for and
to where the packet needs to be routed.
Since the Socket Input Handler utilizes a
synchronous transfer protocol, after each packet it
receives, it responds to the client with either a ‘Success
Packet’ or an ‘Error Packet.’ It is recommended, for the
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Description: Specific identifier for the type of message packet
Name:
Message ID
Type:
long int (32 bits)
Description: Used by client system to identify a
message. Upon response, the Message
ID will be identical to the ID of the
packet being responded to.
Name:
Priority
Type:
short int (16 bits)
Description: Used internally by Smart Alec for routing priority. This feature is not currently implemented. Send a short int
with a value of 0.
Name:
Type:

Arguments
Set of null terminated ( ‘\0’ ) ASCII
character strings. All ASCII characters
are valid except ASCII 0 ( ‘\0’ ).
Description: A set of null terminated strings of data.
The strings are sent sequentially with
only the null terminator in between.
Each class and subclass has its own
packet definition for number of strings
to send and rules for format.
Data Source Variable COS
Description
This type of packet alters the value of a variable
already existing in the Smart Alec system. Typically, this
is used to update a variable on a display device, give
notice of an event, or display general information.
Packet Definition

Class:
SubClass:

8
8
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Arguments: 2 arguments are expected for this type
of message packet
Name:
Var_Name
Limits:
32 characters
Description: Name of the variable as identified in
the database
Name:
Var_Cur
Limits:
128 characters
Description: Updated value of the variable (in null
terminated string format)
Login Packet
Description
This is the first packet that needs to be sent into the
system. If the login values do not match up with a user in
the Smart Alec system, the Socket Input Handler returns
an ‘Error Packet’ indicating an invalid login and the
connection will be terminated. If this is not the first
packet sent, an ‘Error Packet’ is returned indicating that
the user is not logged in yet and the session will be
terminated. If a second login is attempted after a
successful login has already occurred on this connection,
an ‘Error Packet’ is returned indicating that the user is
already logged in and the session continues.
Packet Definition:

Class:
SubClass:

1
1

Arguments: 3 arguments are expected for this type
of message packet
Name:
User_Name
Limits:
64 characters
Description: The name used to identify the account
of a Smart Alec user
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Name:
User_Password
Limits:
255 characters
Description: The password for this Smart Alec user
account
Name:
Limits:

Callback_Port
Between 1024 and 65535 (in ASCII
characters)
Description: The number of a port on the client’s
system that has a listen connection
open in the event of outstanding notifications after a broken connection. In
this case, the socket handler opens a
socket to that port on the client’s system. This feature is not currently
implemented. Send a null terminated
string containing the number 0 (i.e., ‘0’
or ASCII 40.)
Log Message
Description
This type of packet is primarily used as a diagnostic
or debugging tool. It places a message or note directly
into the Smart Alec Event Log, the Socket Input Handler
local log file, and the Smart Alec Trace System.
Packet Definition

Class:
SubClass:

0
0

Arguments: 1 argument is expected for this type of
message packet
Name:
Message
Limits:
64 characters
Description: A message or note to place directly into
the Smart Alec event log, the Socket
Input Handler local log, and the Smart
145

Appendix 6: Socket Interface

Alec event trace system. Smart Alec
logs this message regardless of whether
logging or tracing is enabled.
Socket Command
Description
This type of packet is used to issue a command
directly to the Socket Input Handler. The scope of these
commands is limited, but can prove to be useful. The
tools currently available are based on dynamically
controlling tracing and logging.
Packet Definition

Class:
SubClass:

0
1

Arguments: 1 argument is expected for this type of
message packet
Name:
Command
Limits:
32 characters (Case Insensitive)
Description: A control command to be issued
directly to the Socket Input Handler
Available commands:
- None
Return Packets
These packets are returned upon completion of the
processing of a submitted packet by the Socket Input
Handler. The packet format is the same as with packets
sent into the socket handler. The Message ID that comes
back in this packet is the same ID that was sent in the
original packet.

Success Packet
Description
The success packet is a return packet used in the
synchronous transport protocol to indicate that a packet
entered into the system has been processed by the socket
handler and routed to its proper destination. After
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receiving this packet, the client system is safe to send
another packet.
Packet Definition

Class:
SubClass:

0
2

Arguments: 1 argument is expected for this type of
message packet
Name:
Success Message
Limits:
32 characters
Description: A string indicating that processing is
complete for a client’s message
Error Packet
Description
The error packet is returned when a problem has
occurred either with the incoming packet or within the
Socket Input Handler application. The argument within
the packet gives information on the nature of the error. It
is recommended that the client system examine the
nature of the error and make a determination whether it
should continue sending data.
Packet Definition

Class:
0
SubClass: 3
Arguments: 1 argument is expected for this type of
message packet
Name:
Success Message
Limits:
32 characters
Description: A string indicating nature of the error
that the Socket Input Handler encountered with this packet. These errors are
explained in the “Return Information
Reference” below.
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Return Information Reference
Login Errors
“Login Error - (<Msg ID>) User <Username> not found in system.”
Cause
1.

The user has sent a login packet with a username
not in the system.

1.

Sends a message to the trace and log with the
text above.
Sends an error packet back to the user with the
text above.
The system automatically boots the user by
closing the socket connection.

System Response

2.
3.
Corrective Action
1.
2.

Reconnect and send a valid login name.
Check the Smart Alec program for registered
users.

“Login Error - (<Msg ID>) User <Username> entered an invalid
password.”
Cause
1.

The user has sent a login packet with a username
not in the system.

1.

Sends a message to the trace and log with the
text above.
Sends an error packet back to the user with the
text above.
The system automatically boots the user by
closing the socket connection.

System Response

2.
3.
Corrective Action
1.

148

Reconnect and send the right password.

Appendix 6: Socket Interface
“Login Error - (<Msg ID>) User <Username> chose an invalid port
number: <Port>.”(Not currently being used)
Cause
1.

The user has sent a login packet with a port
number outside the valid range.

1.

Sends a message to the trace and log with the
text above.
Sends an error packet back to the user with the
text above.
The system automatically boots the user by
closing the socket connection.

System Response

2.
3.
Corrective Action
1.

Reconnect and send a valid port (1024 - 65535)

“No User Logged In - Closing Connection”
Cause
1.

The user has tried to send a packet other than a
login packet into the system before the user has
logged in.

1.

Sends a message to the trace and log with the
text above.
Sends an error packet back to the user with the
text above.
The system boots the user by closing the socket
connection.

System Response

2.
3.
Corrective Action
1.

Log back into the system and make sure to send
a login packet first.

“User <Username> is already Logged In”
Cause
1.

The user is trying to send a login packet after a
valid login.

1.

Sends a message to the trace and log with the
text above.

System Response
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2.
3.

Sends an error packet back to the user with the
text above.
The system continues normal operation.

Corrective Action
1.

No corrective action is necessary. Just don’t send
any more login packets.

Data Errors
“Data Error - (<Msg ID>) Class <Class>,<Subclass> is not a valid
packet type”
Cause
1.

The user has sent a packet with an unrecognized
class and subclass.

1.
2.

Sends a message to the trace with the text above
Sends an error packet back to the user with the
text above.
The system discards the packet and flushes
message queue.

System Response

3.
Corrective Action
1.
2.

Make sure the user is sending packets that are
known by the system.
Check the SA version to make sure that type of
packet is supported.

“Data Error - (<Msg ID>) Class <Class>,<Subclass> Argument: <# of
Arg> is out of range. Size = <Size of Arg>”
Cause
1.

The user has sent a packet with data elements
out of the domain set by the API.

1.

Sends a message to the trace and log with the
text above.
Sends an error packet back to the user with the
text above.
The system discards the packet and flushes
message queue.

System Response

2.
3.
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Corrective Action
1.
2.

Check the data to see if the user application is
sending packets out of range.
Change the data to conform to the API
guidelines.

“Data Error - (<Msg ID>) Class <Class>,<Subclass> Argument <# of
Arg> has no value”
Cause
1.

The user has sent a packet with data elements
having size 0.

1.

Sends a message to the trace and log with the
text above.
Sends an error packet back to the user with the
text above.
The system discards the packet and flushes the
message queue.

System Response

2.
3.
Corrective Action
1.
2.

Check the data to see if the user application is
sending packets with 0 size element.
Change the data to conform to the API
guidelines.
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Questions and Answers
Q1. How can I tell what messages should be running?
A. The Command Manager lists all the commands that are set up. In the list, each
command that is currently scheduled has a start time and end time. If there is no
start time or end time, it means that the command, and thus the message, is
shouldn’t be running. Recurring commands always have a start and end time,
even if that time period does not include the current time. Note that you may
need to update the list of commands by choosing Update for a command which
shows an end time earlier than the current time. Or you can close the Command
Manager and reopen it.
Q2. Why isn’t my message showing up?
A. There could be several reasons:
• There may be no command to add the message for the notification device.
• If a variable is supposed to trigger the message, be sure that there is a rule for
the variable, set in Variable Rule Manager.
• The address might not be correct for that notification device. (See “Adding a
notification device: ALPHA, pager, email” on page 39.)
• The sign might not have Smart Alec firmware.
• The RS232/RS485 jumper for a 4000 or 7000 series sign might not be set
correctly. (See the Network Configurations manual, PN 9708-8046.)
A.

Double-check to make sure everything is set up correctly. You can use the
“Flowchart for setting up and using Smart Alec” on page 11 as a guide.

Q3. Why aren’t variables in my messages showing up?
A. Be sure there is a source for the data: DDE, OPC, or sockets. See “Establishing
DDE input data sources” on page 47, “Establishing OPC input data sources” on
page 54, or “Importing external data using sockets” on page 64.
A.
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Q4. Why aren’t the variables in my messages getting updated even though they showed up in
the message when it started?
A. Most likely, the DDE or OPC server is no longer running. Check the server and
the physical connections to it. However, the variable should still be displayed
with the default value.
Q5. What happens if the DDE or OPC source is already running before Smart Alec starts?
A. This is not a problem. Smart Alec is able to access the data correctly.
Q6. I deleted a variable and now the Smart Alec system is running very slowly. Why might
this be?
A. The variable may have been supplied with data by an OPC data source. If so, you
also need to delete that link in OPC Data Source Setup. (This is not a problem if the
data is supplied by a DDE data source.)
Q7. It doesn’t seem as if messages are getting sent to notification devices. What can I do?
A. Under any of the following conditions, you must shut down the Smart Alec
system and then restart it before you can use the change:
• After adding a notification device
• After adding a notification device interface
• After losing a connection to a device
• After adding a DDE or OPC input data source

A.

You should not need to shut down and restart Smart Alec under these conditions:
• Adding or changing a variable
• Adding or changing a message
• After losing a connection to a DDE input data source
Even if you did not recently add a component listed above, try Start > Programs >
Smart Alec again. You do not need to shut down Smart Alec before doing this. If
any Smart Alec background processing applications were not running for any
reason, this will re-start:
• SABar.exe (the primary user interface)
• SAevtmgr.exe (the background event manager)
• Sockhandler.exe (the background socket data manager)
• Saopcsv.exe (the background OPC data manager)
• DDEInputHandler.exe (the background DDE data manager) If this does not
run, it may be that the external data source is not running before starting
Smart Alec. Start the external data source and then start Smart Alec.
• Ez95dm (the data manager for data in messages to signs)
• Ez95sv (the server for messages to signs)
• Alphaout (converts messages that people can read into a format that the
notification device can use)
• Actsrvr (the manager for all activities)
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(In Windows, you can see which programs are running by pressing Ctrl/Alt/Del
together one time. Be sure to choose Cancel here rather than End Task or Shut
Down.)
Q8. How can I be sure that a pager notification device is set up as alphanumeric?
A. All pager devices are assumed to be alphanumeric.
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Hardware diagnostics
When adding signs to a network of signs in the
Smart Alec system, you can perform a test to determine if
a new sign is correctly connected. The Hardware
Diagnostics program allows instant verification that the
network is set up correctly and a sign is connected
correctly.
Signs can be attached to the network at any time,
which means that a sign can be connected to the network
while Hardware Diagnostics is running, and the sign will
respond to the tests within seconds.
1. In Explorer, run HW Diag.exe, which is found on
the original Smart Alec CD in a directory called
Support.

2.

Select the correct COM port for your computer
and select Alpha SA. Then click Start.
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3.

The application will send out test messages to
every sign on the network, that is, signs with
addresses 1 through 255. It starts with message 0
(zero) and goes to message 999 and then repeats
the cycle as long as it is running or until the Stop
button is clicked.

Sign Addr: 1 Msg: 1
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4.

At the end of each message test, the status
indicates the test is complete.

5.

To stop the testing, click the Stop button or close
the program.
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Where to go for additional help
If you need assistance, please follow this procedure:
1. Refer to relevant topics in this manual.
2. Refer to online Help for the specific application.
3. Contact your authorized Smart Alec distributor.

What you need to provide when you need assistance
If you need technical assistance, you will need to
provide:
• full description of the problem
• the sequence of steps that lead up to the problem
• computer system hardware and relevant
software application version numbers
• the version number of Smart Alec found in the
splash screen when Smart Alec starts and also
found in the About screen from the Help menu of
any Smart Alec application.
• the product serial number – found on the outside
packaging and on the registration card
• the version number of any relevant Smart Alec
application, found by right-clicking on the
application in Explorer, choosing Properties then
clicking on the “Version” tab and also found in
the About screen from the Help menu of the
application.
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Administrator

Normally the applications that are needed to set up the
Smart Alec system are available only to an administrator, while
the applications needed for routine management of messaging
needs are available to all users. In an environment where only
one person is responsible for using Smart Alec, this user is also
the administrator, with full access to all applications.
Security is available so that, for instance, applications
needed only by the Smart Alec administrator (to set up the
system) are not accessible by normal users (for general
management of the system.)

Application

A software program which a user can see and use to create,
authorize, or change data. An application can be accessed from
a menu or a toolbar.

Authority

Indicates the level of rights given to a user.

Authorization,
details

Provides the capability to read (view), but not to change, the
information about a subject.

Authorization,
update

Provides the full capability to read (view) and also change
the information about a subject.

Command

A way for a user to communicate a request for a desired
physical action at a notification device. A command consists of
message content, notification device destination, and running
priority. It is formatted according to what is needed for each
particular notification device.
A command can, but does not always, trigger action,
depending on priorities and prerequisite conditions. Pre-set
variable display command rules can control when commands
are processed, or commands can be scheduled by date/time.

Data, private

Data that is made available to only one individual user: the
creator.
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Data, public

Data that is made available to all users.

Dead band

The smallest percentage of change necessary for variables to
be sent to Smart Alec by the OPC server. Similar to delta value,
but is expressed as a percentage, applies to the OPC server and
to all numeric variables in the Smart Alec group.

Delta value

The number that is used to set a “plus or minus” range for
the value of a variable. The value of the variable is compared
with this range. If the value of the variable is outside the range
(higher or lower), then that value of the variable is used to
update the variable wherever the variable is used for a
command. Otherwise, the value of the variable is not updated.

Destination

A place where a message is to be displayed.

Details

If you have enough “details” authorization to use an
application, that application will appear in the SA Bar for you.
You will be able to use that application and view details of any
data in it, but you will not be able to make any changes to it.

Device

Any hardware component attached to the computer system.
Some (notification devices) are used for displaying messages.

Display

Verb: To cause a message to be shown.
Noun: A device on which a message is shown.

Display command
rule

Pre-defined condition(s) with resulting action(s) for how to
use a variable to trigger a command to be issued. Set in Variable
Rule Manager.

Dynamic Data
Exchange

Dynamic Data Exchange, or DDE for short, is a
programming method by which Windows-based computer
applications can exchange data when running simultaneously,
generally on the same computer. This way they can
“communicate” directly and actions in one system can be
triggered by data in another system.
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External data source

A source of data or information outside of the Smart Alec
system. Also known as a data server. One example of an
external data source could be a production line system, such as
Intellution or WonderWare, providing machine statistics, like
the number of parts produced per minute or a machine's
temperature. Another example of an external data source could
be a Microsoft Excel or Lotus 1-2-3 spreadsheet.

Field

One item of information about something. Examples: name,
action, or destination for a display command. Compare with file
and record.

File

A unique, unified set of information. Examples: a Smart Alec
database, a list of the event log, a source of DDE data input, a
Smart Alec application. Compare with field and record.

Message

A unique, unified set (file) of information – a “thought”. It
can be saved and/or sent to a notification device. Its “look and
feel” is based on that specific device.
A message is defined using the Message Manager. It may
include some or all of the following properties, either specified
or defaulted:
•
Text
•
Graphics
•
Formatting (font, font size, color, etc.)
•
Time/date/temperature
•
Variables
•
Animation
A message does not include the following, which are
designated using Command Manager for the message:
•
Scheduling
•
Location/destination
•
Priority
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Multi-user
environment

A “multi-user” environment is appropriate when users
should not necessarily have access to the same applications and
application functions; that is, access can be restricted for some
users for applications, application functions, or system inputs or
resources.
For example, you may want to restrict a clerk’s authority and
not allow that person to send messages to the signs on the
production floor. But you would want the building security
manager to be able to send a fire alarm to every sign. Also, you
might not want either of these people to be able to set authority
for other users.

Notification device

An individual hardware component in the Smart Alec
system which is capable of displaying Smart Alec messages.
Examples are: ALPHA SA signs, email, and pagers. All
notification devices need notification device interfaces.

Notification device
interface

Hardware with software settings needed to communicate
properly with a hardware notification device. Please see
“Appendix 2: Types of Notification Device Interfaces” on
page 124 for descriptions and examples.

Password

A special word to allow a user access to a computer
application or application function.

Priority, execution

The level of authority needed by a user to execute a
command.

Priority, run

The priority of a command on the display, to be compared
with other commands being executed on that display. For
example, two messages, each with a Run Priority of 5, will
alternate on the sign. On the other hand, a message with a Run
Priority of 5 will override a message with a Run Priority of 6.

Record

A collection of related fields. Example: all the information
about one display command. Compare with field and file.

161

Appendix 8: Glossary
SA Bar

The initial Smart Alec application and window from which
you can start any other Smart Alec application for which you
are authorized.

Single-user
environment

A “single-user” environment in Smart Alec might have more
than one user, but all users have full access rights to all
applications, application functions, and system inputs and
resources.

Serial address

A unique number identifying one notification device in a
system.
A serial notification device interface uses cables to connect
ALPHA SA signs into a network, and messages are sent over
this cabling. (See “Serial interface” on page 124.)

System resource

Hardware and/or data within the Smart Alec messaging
system that are created and managed by Smart Alec
applications. Examples are: notification devices, notification
device interfaces, and variables.

Trigger

Verb: Initiate, cause, start
Noun: Something that causes an action to occur

Update

Adjective: If you have enough “update” authorization for an
application, that application will also appear in the SA Bar for
you. You will be able to view details and, in addition, you will
be able to make changes using that application.
Verb: To change to current value

Update rate

The interval time, in milliseconds, for the OPC server to wait
before updating the values of all the items in the entire Smart
Alec group.

User

Any person who is both authorized and set up to submit
information in any way to Smart Alec.
Each user has not only a name and password, but also is
authorized for applications, system resources, data, and
processing.
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Variable

A variable represents real-time (“as it happens”) data that
can change (e.g., temperature or production rates, security lock
status, alarms.) Since its value can change or vary, it’s called a
“variable.” Variables’ values are typically acquired and handled
by Smart Alec’s DDE or socket interfaces.
Variables can be used in two ways:
1. They can be embedded in messages. The value of the
variable gets filled in wherever the variable is used in
an active message, and it is refreshed whenever the
value changes.
2. Variables can also be used to trigger commands for
messages and events to start and stop.
As an example, you could have a variable called
“Temperature” which is continually filled in with values from a
thermometer. The variable could change, for instance, whenever
there is at least a 1-degree change at the thermometer. Then,
whenever “temperature” equals or exceeds 212° F, a message
showing the temperature could be sent to a sign and an alarm
could be triggered to sound.

Variable rule

A rule to govern a variable, what is done with it, and what
happens when its value changes
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